
 

 

Final Report 

 

 

 

 

 

 

to the  

U.S. Fish and Wildlife Service 

 

Recreational Fisheries Habitat Assessment Project 

 

 

 

 

 

 

 

State:   United States Virgin Islands 

 

Project Number:   F-7 

 

Project Title:    Recreational Fisheries Habitat Assessment Project 

 

Study Number: 4 

 

Study Title:    Mapping Essential Fish Habitat with Side Scan Sonar 

 

Period Covered:   October 1, 2001 to September 30, 2005 

 

Report Written by:   Jason Vasques, Fisheries Biologist III 

   Division of Fish and Wildlife 

   Department of Planning and Natural Resources 

   U.S. Virgin Islands  

 

Date of Report :   November 28, 2005 

 

Project Staff:    Shenell Gordon, Fisheries Biologist I 

 

Report Reviewed By: K. Roger Uwate, Ph.D., Chief of Fisheries 

   Barbara Kojis, Ph.D., Director 

 



F-7: Recreational Fisheries Habitat Assessment Project 

Study 4: Mapping Essential Fish Habitat with Side Scan Sonar Final Report 

Period: FY 2001-FY2005 

 

ii 

 

Table of Contents 

List of Tables          iii 

List of Figures         iv-v 

1.0  Introduction and Background      1 

2.0 Site Description        2 

3.0 Side Scan Sonar and Multibeam      2 

 3.1 Geodetic Parameters and Positioning    3 

3.2 Survey Equipment       3 

3.2.1 Survey Vessel       3 

3.2.2 Sonar System       4 

3.3 Survey Operations       4 

3.3.1 Post Processing the Data and Creating Mosaics  4 

4.0 Ground Truthing the Sonar Images     5 

4.0.1 Diver Observations     5 

4.0.2 Drop Video Camera     5 

4.1 Interpreting the sonar images     5 

5.0 Habitat Classification Scheme      7 

5.1 Habitat Classification Descriptions      8 

6.0 Benthic Habitat Maps       10 

6.1 Quantitative Description of Habitats along the Insular Shelf  11 

7.0 Discussion         12 

7.1 Future Work         13 

Acknowledgements         15 

References          16 

Appendix I  Procedures for side scan sonar acquisition   50 

Appendix II  Mosaic procedure basics     56 

Appendix III  Post processing side scan sonar images   59 

Attachment 1  Side scan sonar mosaics      

Attachment 2  Benthic habitats of the insular shelf south of St. John 

Attachment 3  DVD with data and habitat maps 



F-7: Recreational Fisheries Habitat Assessment Project 

Study 4: Mapping Essential Fish Habitat with Side Scan Sonar Final Report 

Period: FY 2001-FY2005 

 

iii 

 

 

List of Tables 

Table 1           18 

Ground truthing coordinates and habitat at each point.  The columns  

labeled type and descriptor describe the structure and make-up of each site. 

 

Table 2          23 

Results of the community composition, 30m photo transects conducted  

on the side scan sonar reef (stj9b-stj10a). 

 

Table 3          24 

Results of the community composition, 30m photo transects conducted  

for a spur and groove reef in stj2a. 

 

Table 4          25 

Structure of NOAA’s classification scheme 

 

Table 5          26 

Habitat classification scheme as presented in Prada Triana (2003). 

 

Table 6          27 

Habitat classification scheme used in this project. 

 

Table 7          28 

List of polygons that were either adjusted or drawn using the multibeam  

data (NCCOS 2004, 2005). 

 

Table 8          30 

Total area for each habitat at the different hierarchical levels of the  

broad habitat layer. 

 

Table 9          31 

Total area and percent contribution of each habitat in the reef  

and hardbottom layer. 

 

 

 

 

 

 

 

 

 



F-7: Recreational Fisheries Habitat Assessment Project 

Study 4: Mapping Essential Fish Habitat with Side Scan Sonar Final Report 

Period: FY 2001-FY2005 

 

iv 

 

 

 

List of Figures 

 

Figure 1          32 

Map of St. John depicting approximate boundaries of the Virgin Islands 

National Park, Virgin Islands Coral Reef National Monument, and  

area surveyed with side scan sonar. 

 

Figure 2          33 

Side scan sonar survey area with survey grids. 

 

Figure 3          34 

Ground truthing locations. 

 

Figure 4          35 

Ground truthing of submerged vegetation. 

 

Figure 5          36 

Ground truthing of rhodoliths and macroalgae on the bank shelf. 

 

Figure 6          37 
Ground truthing of rhodoliths and magroalgae on the shelf platform. 

 

Figure 7          38 

Ground truthing of spur and groove habitats. 

 

Figure 8          39 

Ground truthing of patch reefs. 

 

Figure 9          40 

Ground truthing of coral reef habitats. 

 

Figure 10          41 

Ground truthing of colonized bedrock habitats. 

 

Figure 11          42 

Ground truthing of colonized pavement. 

 

Figure 12          44 

Ground truthing of scattered coral/ rock. 

 

Figure 13          45 

Example of scattered coral/ rock and MMU. 

 



F-7: Recreational Fisheries Habitat Assessment Project 

Study 4: Mapping Essential Fish Habitat with Side Scan Sonar Final Report 

Period: FY 2001-FY2005 

 

v 

Figure 14          46 

Example of side scan sonar and multibeam to adjust polygons. 

 

Figure 15          47 

Differences between the broad habitat layer and reef and hardbottom layer. 

 

Figure 16          48 

Total area (km
2
) of each habitat in the broad habitat layer.  The artificial  

reef category has been omitted as it contributed less than 0.01km
2
. 

 

Figure 17          48 

The average area (km
2
) of polygons drawn for each habitat type in the 

 broad habitat layer.  Again artificial reefs have been removed. 

 

Figure 18          49 

The total area (km
2
) of each habitat in the reef and hardbottom layer. 

 

Figure 19          49 

The average area (km
2
) of polygons drawn for each habitat in the reef  

and hardbottom layer. 

 

 

 



F-7: Recreational Fisheries Habitat Assessment Project 

Study 4: Mapping Essential Fish Habitat with Side Scan Sonar Final Report 

Period: FY 2001-FY2005 

 

 

1 

 

1.0 Introduction and Background 

The role of GIS in fisheries and coastal management has increased dramatically in recent years.  

Fishery managers must consider such spatial questions as recruitment patterns across marine 

ecosystems, the influence of ocean currents or habitat availability on fish populations (Rahel 

2004).  Advances in the technology used to identify and quantify benthic habitat are providing 

information necessary for the spatial management of marine resources (Bax et al. 1999).  Critical 

to developing models for the spatial management of fisheries and habitat suitability indices is an 

accurate description of the abundance and distribution of essential habitats (Battista & Monaco 

2004) with knowledge of the association of fishes with those habitats (Bax et al. 1999).   

 

The US Virgin Islands supports a large recreational fishery.  Increasing pressures on the reef 

resources has led to the need to identify and quantify critical habitats.  Data are lacking on the 

benthic habitats that support the recreational fisheries of the U.S. Virgin Islands.  This is 

particularly true of the deeper water shelf habitats of the Virgin Islands.  Until recently, benthic 

marine habitat maps in the US Virgin Islands have consisted primarily of nearshore, shallow 

water environments.   NOAA produced maps of nearshore habitats based on aerial photography 

(Kendall, et al. 2001).  However, use of aerial photography to map and define benthic habitats is 

depth limited.   

 

Two methods for collecting information on benthic habitats in deeper or turbid waters are side 

scan sonar and multibeam.  Recent side scan sonar surveys include McRea et al. 1999, Gingras et 

al. 2000, Kendall et al. 2001, Cochrane & Lafferty 2002.  Under a contract through the 

Caribbean Fishery Management Council Geophysics GPR International (2003) conducted 

multibeam and side scan sonar surveys offshore of St. Thomas and St. Croix.  Geophysics GPR 

International (2003) and Prada Triana (2003) created benthic habitat maps of the Hind Bank 

Marine Conservation District, along the shelf edge south of St. Thomas.   

 

In an effort to describe the benthic habitats of the US Virgin Islands the Division of Fish and 

Wildlife initiated studies to map and identify benthic marine habitats for incorporation into a GIS 

database.  Early efforts include the characterization of habitat in the Cas Cay/ Mangrove Lagoon 

and St. James Marine Reserves (Chapman 1996, Adams et al. 1998, and Volson 2001).  Mapping 

efforts include the use of an ROV to record video of subtidal habitats (Chapman et al. 1996).  

This project met with substantial difficulties and was subsequently altered to include the use of 

side scan sonar.   

 

Since 2001 side scan sonar has been used to map subtidal habitats of the insular shelf south of St. 

John as part of a US Fish and Wildlife Service funded grant.  The objective of this grant was to 

characterize the various shelf habitats that support recreationally important fisheries in the Virgin 

Islands and to quantify the extent of each habitat type on the insular shelf platform south of St. 

John.  It is anticipated that the information gleaned from this study can be combined with the 

nearshore habitat maps produced by NOAA/NMFS (Kendall et al. 2001) and the offshore habitat 

maps produced by Geophysics GPR International (2003) and Prada Triana (2003).  Through the 

development of a series of habitat maps that span the entire shelf south of St. Thomas and St. 

John fisheries resources can better be assessed and managed.   
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2.0 Site Description 

The island of St. John, US Virgin Islands is part of a volcanic chain of islands.  The island is 

dominated by steep mountainous terrain.  Much of the island is part of the Virgin Islands 

National Park, including some nearshore waters (Figure 1).  In 2001 the Virgin Islands Coral 

Reef National Monument (Figure 1) was created by presidential proclamation.  South of St. John 

the national monument covers approximately 4,369.27 ha of submerged land.  The insular shelf 

south of St. John is managed by several agencies, the National Park Service, the US Virgin 

Islands territorial government, and the National Marine Fisheries Service.  Therefore, there are 

several agencies that potentially benefit from this project.   

 

The shelf platform extends approximately 9 nm to the shelf edge (south drop) where depths 

plummet from as little as 30 m to more than 1,000 m.  Midway along the shelf platform is the 

midshelf ridge, also commonly referred to as the midshelf reef.  Depth along the bank shelf 

shoreward of the midshelf ridge vary between 1 to 30 m and offshore of the midshelf ridge 30 to 

50 m.   

 

The survey areas was designed to overlap with a fishery independent reef fish assessment 

project, the Southeast Area Monitoring and Assessment Program – Caribbean (SEAMAP-C) trap 

study.  The intent was, in addition to the objectives of this project, to allow for an analysis of reef 

fish abundance and habitat associations.  Therefore, an area of approximately 64 square nautical 

miles was initially divided into sixteen 4 nm
2
 survey grids, numbered 1 to 16.  These were 

further broken into 1 nm
2
 grids, numbered 1a to 1d, 2a to 2d etc.., extending from the south shore 

of St. John to the shelf edge (Figure 2).  Several of the 1 nm
2
 grids lie in waters off the shelf edge 

and were therefore too deep to be surveyed and included in this project.     

 

 

3.0 Side Scan Sonar and Multibeam 

Side scan sonar and multibeam were collected during this project.  Approximately 52.62 km
2
 

(19.17 nm
2
) of side scan sonar data were collected.   Of that, roughly 10 nm

2
 were collected 

directly by the Division of Fish and Wildlife.  The remaining area was collected through a 

collaborative effort with the US Environmental Protection Agency.  In February 2002 onboard 

the OSV PW Anderson, the US EPA with DFW staff collected side scan sonar data of survey 

areas stj9a to stj12b (see Figure 2).  This data was collected using a dual frequency Klein 595 

towfish.  Horizontal and vertical positioning was accounted for during the survey, however, that 

information is not reported here.  The data from this survey effort was provided to DFW and is 

included in this report.   

 

In addition to collecting side scan sonar data, DFW collaborated with NOAA’s National Ocean 

Service, National Centers for Coastal Ocean Science, Biogeography Team to collect multibeam 

data south of St. John and St. Thomas.  Although the multibeam data were not directly used to 

delineate habitats, it was useful in discriminating feature boundaries and correcting the positions 

of features.  

 

In February and March 2004 approximately 91.06 km
2
 of multibeam data were collected (NOAA 

NCCOS, 2004).  This data was made available to the Division of Fish and Wildlife.  Information 
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regarding this mission is available at the following website: 

http://biogeo.nos.noaa.gov/foster_mission_2004.  

 

In 2005 another mission to collect multibeam data was conducted.  During this mission 

approximately 39.9 km
2
 of data was collected on the Grammanik Bank, St. Thomas, roughly 

38.52 km
2
 in the Virgin Islands Coral Reef National Monument, St. John, and more than 18 km

2
 

off of St. Thomas continuing from the 2004 data set (NOAA NCCOS, 2005).  Information 

regarding the 2005 survey mission is available at: 

http://biogeo.nos.noaa.gov/foster_mission_2005.   

 

 

3.1 Geodetic Parameters and Positioning 

The projection used during all survey operations was the Universal Transverse Mercator (UTM) 

zone 20N.  The datum used in all surveys was WGS-1984.  Vertical positioning was not 

accounted for during surveys since tidal variation is slight and manually correcting the data for 

tidal influence was out of the scope of this project.  It is not believed that vertical variation was 

great enough to affect the positioning of features for the level of detail included in the final 

habitat maps.   

 

Vessel positioning was sent from the GPS unit to a laptop computer running the navigation 

software HYPACK MAX by HYPACK, Inc. (formerly Coastal Oceanographics, Inc.).  The 

survey vessel followed preplanned survey lines from the positioning provided in the navigation 

software.  Survey lanes were created using the HYPACK MAX software.  Twenty-five survey 

lanes were created for each ~1 nm
2
 survey grid.  Each survey lane spanned 100 m in width, 50 m 

on either side of the towfish.  Approximately 25 m of overlap was created for each survey lane to 

ensure 100% coverage while allowing for minimal vessel wander.   Position information was 

also routed to the sonar acquisition computer to provide real time positioning in the sonar record. 

 

 

3.2 Survey Equipment 

 

3.2.1 Survey Vessel 

The survey platform for the majority of this study was DFW’s 27 ft. diesel trawler R/V Lindsey.  

A DC electric winch was used to control the length of cable and subsequently the towfish height 

off the seafloor.  The height of the tow point was 1.63 m from the surface of the water when the 

boat was resting at dock.  Positioning during surveys was accomplished using a WAAS enabled 

Raytheon RC425 chart plotter GPS.  The GPS receiver was positioned approximately midship 

above the wheelhouse.  The offset from the receiver to the tow point was 6.27 m.  The survey 

vessel was also fitted with a Furuno FCV-582L depth sounder.   

 

The survey equipment operated off of a 24 volt battery bank charged via two solar panels 

mounted to the top of the vessel.  A ‘true’ sinewave 1000 watt power inverter provided 120 VAC 

for the computers.   
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3.2.2 Sonar System 
The side scan sonar system consisted of a single frequency 300 kHz towfish by Marine Sonic 

Technology, Ltd.  The towfish was fitted with a stainless steel ballast, weighing approximately 

45 lbs, mounted to the underside of the towfish.  A wing depressor was also fitted on top of the 

transducers to assist in the towfish descent.  The sonar acquisition software that was used was 

Sea Scan PC by Marine Sonic Technology, Ltd.  The range of the sonar transducers was set at 50 

m on either channel allowing for a 100 m swath width.  Numerous towcables of varying length 

were used throughout the project.   

 

 

3.3 Survey Operations 
The survey crew generally consisted of three people, the captain, the survey operator, and a deck 

hand to assist in deploying and retrieving the towfish.  During survey operations the vessel speed 

was maintained between 2.5 to 3.5 knots.  As mentioned above, the captain followed preplanned 

survey lines.  The sonar operator monitored the sonar image and adjusted the gain balance for 

optimal image clarity.  The survey operator also controlled the winch.  Adjustments of the cable 

altered the height of the towfish off the seafloor.  The towfish was towed at an altitude of 3 to 7 

m off the seafloor.   

 

The SeaScan PC software by Marine Sonic Technology, Ltd was used during data acquisition.  

During data acquisition the sonar operator recorded into an excel spreadsheet the ID number for 

the survey line and the survey grid, the filename, date, time, direction of the ship, water depth, 

the length of the cable out, and calculated the layback.  The towfish did not have a depth 

transducer so layback had to be calculated manually using the equation: 

( ) oahdcLayback +




 −+−=

22  

Where (c) is the length of cable out, (d) is the water depth, (h) is the height of the towpoint, (a) is 

the altitude of the towfish (or height off the seafloor), and (o) is the offset.  As mentioned above 

in section 3.2.1 the height of the towpoint is h = 1.63 m and the offset o = 6.27 m.  This layback 

value was entered into the excel spreadsheet to facilitate manually adding layback into the raw 

sonar image file later.  Basic survey procedures and equipment setup are provided in Appendix I.   

 

 

3.3.1 Post Processing the Data and Creating Mosaics 

The side scan sonar image files were post processed to filter out ambient and vessel noise.  Basic 

post processing procedures are presented in Appendix II.  The SeaScan PC software by Marine 

Sonic Technology, Ltd. was used to post process the images.  Once all the files for a survey day 

were filtered they were recorded on a CD as a back-up.   

 

Mosaics of the data were created with a 0.1 m resolution using the software Isis Sonar and 

DelphMap by Triton Elics, Intl.  The sonar image files were converted from .mst files to .xtf files.  

Each 1 nm
2
 survey grid was composed of 25 survey lines.  Each survey line contained 10 to 12 

survey files.  All of the files for a single line were ‘snipped’ together.  Layback was added 

manually and the files were processed for the final mosaic.  Mosaic procedures are presented in 

Appendix III.  After all 25 lines that compose a single survey area were mosaicked, they were 
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exported as a single GeoTIFF file.    Mosaics of each completed survey area are presented in 

Attachment 1 and as on the included CD.   

 

 

4.0 Ground Truthing the Sonar Images 

Several methods were used to validate the side scan sonar images.  Representative areas in the 

sonar record were selected for examination.  Additionally select features were examined.  Select 

features, such as reefs, were examined to validate the reef composition (i.e. living coral or 

gorgonians) and assist in delineating the features edges in the final habitat maps.  In all cases 

underwater visual confirmation was conducted either by divers or digital drop video camera.   

 

 

4.0.1 Diver Observations 

Divers were used to provide feedback on the habitat and structure for selected areas or features 

of interest.  The coordinates for features were derived from the geo-referenced side scan sonar 

mosaic.  To ground truth areas, divers descended at pre-selected coordinates that were 

representative of a certain habitat type.  The divers swam transects following pre-selected 

compass bearings.  The direction of the dive was chosen such that different habitat types could 

be crossed.  Additionally, dive profiles were planned in an effort to locate one feature after 

leaving another feature and cross a different habitat enroute.  On each dive, one diver towed a 

surface float.  Once on the bottom the diver tugged on the surface float.  The boat operator 

navigated the boat directly above the divers and recorded the GPS coordinates.  The second diver 

took digital video or digital photographs of the habitat and recorded the habitat type.  The dive 

team then continued along the transect and when the habitat changed the dive team repeated the 

above steps recording the new habitat.  At the end of the dive the dive team tugged on the surface 

float and recorded the habitat as above.   

 

 

4.0.2 Drop Video Camera 

In areas that were too deep to dive safely a drop video camera, by SeaViewer Cameras Inc., with 

GPS overlay was used to determine the benthic habitat.  As described above in section 4.0.1 GPS 

coordinates were determined for selected areas or features.  The drop camera was deployed and 

drifted just above the bottom.  A record of the position, date, time, depth, length of cable 

deployed, and habitat was kept.  GPS coordinates were overlayed on the video record so points 

in the video could be extracted and the track of the drop camera drift could be positioned on the 

side scan sonar images.  The video was then analyzed and the habitat was described.  The video 

is provided on the included DVD as .wmv files.   

 

 

4.1 Interpreting the sonar images 

The coordinates recorded during the ground truthing were entered into ArcGIS 9.0 and overlayed 

on the side scan sonar mosaic.  This allowed the dive transect to be accurately positioned over 

the corresponding habitats.  Figure 3 illustrates the locations of ground truthing points conducted 

by both diver surveys and drop video camera surveys.  Each station was given a habitat 

classification based on the divers’ notes and video or photo documentation.  Table 1 is a list of 

ground truthing coordinates and the habitat information that was collected for each site.   
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Habitat validation proved very useful in interpreting the side scan sonar images.   With the 0.1 m 

resolution in the side scan sonar mosaics numerous features could be described.  At a small scale, 

these communities can be delineated.  However at the scale the habitat maps were drawn (see 

section 6.0), the sonar mosaic becomes ‘messy’, due to noise in the images or layback not lining 

up between survey lines.  Thus in the final habitat maps these small scale communities were not 

delineated.  It should be noted however that if the need to define these communities at a small 

scale, the side scan sonar images could allow for this on a line by line basis rather than for an 

entire survey grid.  In these figures, the photos correlate directly to the side scan sonar image.  

Thus interpretation of the sonar image can be made. Figures 4-12 provide examples of habitat 

validation and an interpretation of the sonar record.   

 

Submerged vegetation can be distinguished in the side scan sonar mosaics.  Seagrass habitats 

were found in shallow waters and provided two types of sonar return (Figure 4).  Seagrass 

appeared as round patches or with a soft grainy appearance.  In many instances, particularly in 

the rhodoliths/ macroalgae habitat categories, the resolution of the side scan sonar image was 

finer than applicable as discussed above.  For example, in Figures 5 and 6 various rhodolith and 

macroalgae communities are apparent.  In shallower waters on the bank shelf (see section 5.1 for 

zone description), rhodolith and macroalgae communities provide highly variable sonar returns.  

One of the more interesting results is the presence of what ordinarily would look like sand 

ripples caused by wave action.  However, in most cases south of St. John these ripples are 

actually formed by rhodoliths moved by wave action (Figure 5d-f).  Additionally, the presence of 

infauna can be seen in sand or rhodolith/ macroalgae communities (Figure 5m-o).  Offshore of 

the midshelf ridge rhodolith communities have very little fleshy macroalgae growth and appear 

with a smoother texture in the side scan sonar record (Figure 6a-c).  Generally rhodolith 

communities ‘turn over’ from environmental forces at regular to semi regular intervals.  

However, along the shelf platform of St. John they appear to be more stable since small hard 

coral colonies can be found recruited to them (Figure 6d-f).   

 

Reef and hardbottom habitats can also be distinguished in the sonar record.  Spur and groove 

habitats provide a strong sonar reflectance and have a striated appearance (Figure 7).  Similarly 

patch reefs rise steeply from the substrate and provide a strong sonar return (Figure 8).  Bank 

reefs and linear reefs provide a strong reflectance with numerous oblong structures (Figure 9).  

Along the deeper reefs the interface between a reef and the surrounding habitat is often obscured 

by the fact that along the edges of the main feature there is usually a mix of living coral and 

gorgonians (colonized pavement) or scattered coral and rock (Figure 9a-c).  Colonized bedrock 

was found only near shore and resulted in a high relief and high reflectance in the sonar return 

(Figure 10).  Colonized pavement on the other hand was found throughout the survey area and 

yielded differing sonar returns (Figure 11).  The reflectance of the colonized pavement habitats 

was dependant on the relief of the structures.  The side scan sonar images from this habitat can 

appear as spur and groove returns (Figure 11a-c and 11j-l) except that in general they appear as 

lower relief than a spur and groove coral reef habitat.  Other side scan sonar images for the 

habitat appear flat with a few scattered rocks or barrel sponges (Figure 11d-f) and in some places 

become difficult to discern from other surrounding habitats (Figure 11m-o).  Finally along the 

shelf platform offshore of the midshelf ridge an additional habitat type was found.  The sonar 

record appeared similar to a linear reef or bank reef except these areas consisted of rock, 
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presumably old dead coral heads, which had limited hard coral growth and small sparsely 

distributed gorgonians (Figure 12).  These areas were classified as scattered coral/rock.   

 

Several collaborations were established to augment ground truthing.  Ground truthing was 

conducted in collaboration with the University of the Virgin Islands during their efforts to locate 

potential grouper and snapper spawning aggregations.  These dives followed the protocol 

discussed above and are included as sites in Table 1.  Additional surveys conducted with 

personnel from the University of East Anglia, England resulted in quantitative habitat analysis.  

During these surveys five 30 m transect tapes were lain along a reef and which high resolution 

digital photographs were taken every 1m at a fixed height off the substrate.  The photos were 

analyzed by placing a set number of random points on each image and identifying the substrate 

to species level.  This allowed for the community composition to be described.  Tables 2 and 3 

provide the results of the two surveys conducted on reefs in survey areas stj10a and stj2a, 

respectively.  Additionally the results of these two surveys are provided as hyperlinks in the final 

ArcGIS project in the ground truthing layer.   

 

 

5.0 Habitat Classification Scheme 

Habitat classification schemes often vary regionally as well as locally.  Unfortunately, 

inconsistency in coastal habitat classification can hinder the use of habitat maps in coral reef 

management and coastal resource management (Mumby & Harborne 1999).  Therefore, efforts 

were made in this project to maintain some level of consistency with existing local habitat 

classification schemes (see Kendall et al. (2001), Geophysics GPR International (2003), and 

Prada Triana (2003).   

 

Due to the wide acceptance of the habitat classification scheme developed by Kendall et al. 

(2001), where possible, the habitat categories developed by Kendall et al. (2001) were used in 

this project.  The habitat classification scheme developed by Kendall et al. (2001) was a 

hierarchical scheme which was based largely on geomorphological characteristics.  At the broad 

scale geographic zones were delineated followed by discrete habitat units.  Subcategories within 

a particular habitat unit were also categorized with widely used structural definitions followed by 

a fourth level that described the amount of cover (see Table 4).  However, in many circumstances 

the geomorphological approach used in Kendall et al. (2001) did not match the geomorphology 

and habitat found on the shelf platform south of St. John.   

 

Another habitat classification scheme as presented in Geophysics GPR International (2003) and 

Prada Triana (2003) utilizes a more in situ descriptive classification in which the biologic 

component drives the habitat classification (Table 5).  As in Kendall et al. (2001) this was also a 

hierarchical scheme in which the broadest level described the meta-community in a biological 

context rather than geomorphologically.  The next sublevels also use biological and ecological 

descriptions. The fourth level describes the amount of cover of a particular habitat and is more 

geomorphological than the first three levels, for example ‘gorgonian limestone’ uses both a 

biological and geomorphological description.  In many instances the descriptions used by Prada 

Triana (2003) match the habitats found along the insular shelf south of St. John more closely 

than Kendall et al. (2001).  However, this classification scheme is new and is not as widely used 

as Kendall et al. (2001).   
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Therefore, this project attempts to utilize the classification scheme developed in Kendall et al. 

(2001) with some modifications similar to Prada Triana (2003) and other modifications used 

only to describe this project.  The habitat classification scheme developed for this project is also 

a hierarchical classification scheme (Table 6).  The habitat maps developed by Kendall et al. 

(2001) and Prada Triana (2003) utilized an automated habitat digitizer extension created by 

NOAA’s NOS Biogeography Team for ArcView 3.x.  The habitat maps created in this project 

were created using ArcGIS 9.0 and at the time the habitat maps were created for this project no 

such extension was available.  Therefore, the hierarchical scheme in the maps was developed by 

entering the values for each polygon in the attribute table manually.   

 

The classification scheme basically contains four levels with two descriptive columns (Table 6).  

At the broadest level the zones are defined.  The zones are geographic areas on the insular shelf 

from the shoreline to the shelf edge.  The next level is broad scale habitat.  Broad habitats are 

general substrate categories.  The habitat level provides basic habitat information with general 

definitions.  The category level provides a more descriptive definition of the habitat.  The two 

additional columns in the attribute table ‘Desc_1’ and ‘Form’ provide descriptions about a 

specific habitat category.  The ‘Desc_1’ column identifies patch reefs as either individual patches 

or aggregate patch reefs and identified the type of artificial structure.  The ‘Form’ column 

provides a description of the growth form of corals to be expected.  The two growth forms are 

shallow coral, which is the typical columnar and boulder type shallow water form, and plating 

coral, which is typical of the deeper habitats. These areas generally have the plating growth 

forms of Agaricia spp. and Montastraea spp.  

 

 

5.1 Habitat Classification Descriptions 

Zone 

Bank shelf - This zone is similar in description to bank shelf as used in Kendall et al. (2001) in 

that this zone is the shelf platform offshore of the shoreline except that this zone does not extend 

out to the shelf edge.  Instead bank shelf is used to describe the shelf platform between the 

shoreline and the mid-shelf ridge, a historic (on geologic time scales) reef structure that follows 

the contours of the shelf platform.   

 

Midshelf ridge - This zone describes the ridge like feature that run relatively horizontal to the 

shelf edge and shoreline.  This zone is offshore of the bank shelf.  The midshelf ridge appears to 

be a relict reef crest that has been flooded with sea level change.  Thus it no longer displays the 

classic back reef, reef crest, and fore reef zones.  For this reason, all three zones are encompassed 

in the midshelf ridge.  The midshelf ridge is also commonly referred to as the midshelf reef, 

however along the areas surveyed in this study the reef appears eroded, has limited live hard 

coral and more represents a ridge.   

 

Shelf platform - The shelf platform is the zone between the offshore side of the midshelf ridge 

and the shelf edge also referred to as the outer shelf platform in this report.  This zone is similar 

to the bank/ shelf described in Kendall et al. (2001) between the fore reef and the bank/shelf 

escarpment.  The shelf platform around St. John is generally deeper than the bank shelf.  
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Shelf edge - The shelf edge is similar to the bank/shelf escarpment in Kendall et al. (2001) and 

in many places it forms a ridge like structure.  The shelf edge is the zone that drops off 

precipitously.  Unlike the surveyed portions of the midshelf ridge, along the shelf edge lie 

several deep coral reefs.   

 

Habitat descriptions 

Unconsolidated Sediment - Unconsolidated sediment have little or no vegetation, see (Kendall 

et al. 2001) for description.   

• Sand - Coarse sand has little submerged vegetation and few to no sessile invertebrates.  

This is similar in definition to Kendall et al. (2001) and Prada Triana (2003).   

Submerged Vegetation - Submerged aquatic vegetation that can include seagrass and other 

fleshy macroalgae (see Kendall et al., 2001 and Prada Triana, 2003 for descriptions).  

Additionally, since rhodoliths are such a large component of the insular shelf in the US Virgin 

Islands they were included in this category (see discussion below).   

• Seagrass - Predominately Thalassia testudinum and Syringodium filiforme in this survey 

area.  This habitat was only found nearshore.  See Kendall et al. (2001) for a description.   

• Rhodoliths/ macroalgae - Any combination of rhodoliths (cf. Lithothamnion ruptile) 

and other fleshy macroalgae.  Rhodoliths form small calcareous nodules that act much 

like rubble.  In general rhodoliths move with wave action therefore there is usually little 

epiphytic growth and rhodoliths could be categorized as rubble or unconsolidated 

sediment.  However in the deeper waters along the insular shelf of St. John wave energy 

is reduced and rhodoliths exhibit varying degrees of epiphytic macroalgae growth even 

including small Scleratinian corals.  Rhodoliths are often associated with the fleshy 

macroalgae Lobophora variegatta thus are combined into the single habitat category.   

Reef and Hardbottom - Any rocky or calcium carbonate substrate.   

• Coral Reef - Substrates composed of Scleratinian coral with varying degrees of live 

cover.  

o Spur and groove - A coral reef with deep to moderately deep channels of 

alternating sand and coral cut into the reef structure.  Channels generally run 

perpendicular to the shoreline or prevailing currents. 

o Patch Reef - Coral reefs that are separated from other reef structures.  Patch 

Reefs may vary in size and may be found isolated (individual) or in close 

proximity to either other patches (aggregate) or coral reefs.  Patch reefs generally 

rise sharply off the surrounding substrate.   

o Linear Reef - A coral reef that follows the contours of the shoreline, midshelf 

ridge, or shelf edge, see description in Kendall et al. (2001).   
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o Bank Reef - A coral reef that does not follow the contours of the shoreline, 

midshelf ridge, or shelf edge as above.  Bank reefs may have no particular 

orientation and may lie either along the bank shelf or outer shelf platform.   

• Colonized Hardbottom - Substrate composed of limestone or bedrock that is not 

primarily composed of living coral.  This category may have limited Scleratinian coral 

growth (usually small isolated colonies) and may have varying degrees of gorgonian 

growth. 

o Colonized Bedrock - A rocky substrate usually along the shoreline that has 

gorgonian growth and limited stony coral growth, see description in Kendall et al. 

(2001).   

o Colonized Pavement - Calcium carbonate substrate that has eroded leaving a 

substrate of relatively low relief.  The predominate coverage is from gorgonians 

and sponges and a limited amount of stony coral growth, see description in 

Kendall et al. (2001).   

• Scattered Coral/ Rock - Small coral colonies or rocks that are generally sparse in 

unconsolidated sediment and are too small to delineate as patches, see sand and 

invertebrate category in Prada Triana (2003) for description. Additionally, this category 

includes a unique habitat that was found along the shelf edge and shelf platform which is 

similar to colonized pavement and scattered coral/rock.  These areas contain a high 

density of limestone rocks that appear to be dead coral with some gorgonian growth and 

limited stony coral growth (see Figure 12).   

Artificial - Any structure that is anthropogenetic in nature.  These may be small boats or debris 

that was either lost at sea or scuttled.   

 

 

6.0 Benthic Habitat Maps 
Habitat delineation was facilitated by side scan sonar imagery.  A total of 17 GeoTIFF mosaics 

were used to create the final habitat maps.  ArcGIS 9.0 developed by ESRI was used to generate 

the habitat maps in this project.  Habitat features were visually discriminated in each side scan 

sonar mosaic.  The final habitat maps are presented as Attachment 2.  Since the survey area was 

such a large area, habitat maps that display the entire survey area may not be very useful.  

Therefore, PDF files and a CD containing smaller sections of the habitat maps are also provided 

(Attachment 3).  These will be posted on the Division of Fish and Wildlife’s web page: 

http://www.vifishandwildlife.com.   

 

Due to the highly variable quality of the side scan sonar imagery, the habitat maps were drawn at 

differing scales.  Two habitat maps were created (Attachment 2).  The first was a broad scale 

habitat map in which features were drawn at a larger scale of 1:2000.  This layer of the map is 

labeled the broad habitat category.  At the scale this layer was drawn, it was often difficult to 

discriminate the edges of certain features.  Therefore there is likely to be some variation between 

the drawn edge in the habitat map and the true feature in the field.  NOAA created a habitat 
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digitizer extension for ArcView 3.2 which allowed for the setting of a minimum mapping unit 

(MMU) whereby an attempt to draw polygons that did not meet the MMU were not allowed.  

Therefore maintenance of the MMU was automated.  In this project, ArcGIS 9.0 does not have 

such a feature therefore adhering to a strict MMU was difficult.  Nevertheless, the minimum 

mapping unit used in the broad habitat category layer was 50 m
2
, although some allowances were 

made for the artificial category and a few other features that were isolated structures and could 

be easily delineated.  

 

Individual features that were larger than the MMU but were obviously a component of a larger 

habitat and contained features smaller than the MMU were included in a single polygon for the 

larger habitat unit.  For example, in several scattered coral/rock habitat polygons some individual 

features were larger than the MMU but a polygon was drawn around all of the features in that 

habitat unit (see Figure 13).  Additionally, at the broad scale, habitat polygons were drawn 

around entire patch reef structures rather than individual patches.   

The availability of the high resolution multibeam provided by NOAA’s NOS Biogeography 

Team (section 3.0) allowed for a high precision in positioning of certain features.  Since 

multibeam provides high resolution bathymetry it was useful in delineating the edges of features 

with high relief such as reef and hardbottom habitats. For this reason a second layer was created 

in which reef and hardbottom structures were delineated at a smaller scale and a higher level of 

positional accuracy.  In this layer, side scan sonar was still the primary tool for delineating 

habitat.  Multibeam was overlain with side scan sonar images where both were available.  The 

transparency in the properties for the side scan sonar layer were set at 40% transparent to allow 

the viewer to see through the side scan sonar yet retain the ability to see the habitat features 

(Figure 14).  Further, because of the often poor positional accuracy of the side scan sonar, due to 

manually inserting layback after data acquisition, some polygons were shifted to line-up with the 

multibeam positioning (Figure 14).  For the purposes of habitat delineation, polygons were 

initially drawn around features in the side scan sonar images those polygons were then manually 

shifted to correspond with the same feature in the multibeam.  In a few instances, the side scan 

sonar coverage ended on a reef and hardbottom feature.  In these cases the multibeam was used 

to finish constructing the polygon.  Table 4 lists the polygons that were either shifted or drawn 

using the multibeam data.   

Combining the side scan sonar and multibeam technologies allowed for a highly detailed map of 

reef and hardbottom features to be drawn.  Also because of the strong sonar reflectance of these 

structures, features were delineated at a scale of 1:600.  Rather than attempting to adhere to a set 

MMU in this layer, polygons were created around side scan sonar returns that were visually 

distinct from one another. Therefore, the detail in patch reefs is far greater than in the broad 

habitat layer.  Only two features in this layer were not delineated at the individual structure level.  

The scattered coral/rock features described above and in Figure 13 were too complex to delineate 

individual features and maintain usefulness to the map user.  Likewise due to the poor image 

quality and the complex nature of the bank reef in survey areas stj11a and stj11b (Figure 15), a 

lower precision can be expected in the boundaries for polygons of that bank reef.  Further, within 

any polygon in that area (Figure 15), it may be possible to have multiple habitats that were not 

distinct.  In the deeper regions of the shelf platform, habitat boundaries were not as distinct as 

along the bank shelf or midshelf ridge.  These areas contained rhodolith plains, with little to no 
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fleshy macroalgae and some small scattered coral that recruited on the rhodoliths.  These 

rhodoliths plains merged into colonized pavement or scattered coral/rock habitats then onto bank 

reefs with plating coral.  The boundaries between these habitats were often difficult to discern 

visually.  

 

6.1 Quantitative Description of Habitats Along the Insular Shelf 

Habitat coverage is presented in Attachment 2 as habitat maps.  Since two layers were created 

for habitats, there will be some differences in the total area of any given habitat between the 

layers.  Therefore the total area covered by a habitat was determined for each layer.  Figure 16 

provides the total area (km
2
) each habitat covered in the broad habitat layer.  At the highest level 

in the broad habitat layer, submerged vegetation covered the 77.1% of the total surveyed area 

while reef and hardbottom habitats covered 22.3% (Table 8).  Interestingly, unconsolidated 

sediment only accounted for 0.6% of the total surveyed area.  However, if one were to consider 

rhodoliths as unconsolidated sediment, this contribution would increase significantly.  When 

habitats are broken down in this layer, bank reef contributes 13.6% to the total area covered.  

Table 8 lists the area and percent of the total area each habitat covered at each of three of the 

hierarchical levels.  The average polygon area for a particular habitat in this layer is presented in 

Figure 17.   

The total areas and percent contribution of each habitat in the reef and hardbottom layer are 

presented in Table 9.  As in the broad habitat layer, bank reefs contribute the most (55.95%) to 

the total area covered by reef and hardbottom habitats.  The total areas covered by reef and 

hardbottom habitats are illustrated in Figure 18.  The average polygon areas for each reef and 

hardbottom habitat are presented in Figure 19.  The average area for bank reefs was just over 

0.12 km
2
.  Knowing the average area for a habitat type may reveal some information as to how 

large an average feature is in the survey area.   

 

7.0 Discussion 

Side scan sonar and multibeam technologies provided a platform to create benthic habitat maps 

of the insular shelf south of St. John.  Although the areas surveyed in this project are 

discontiguous, they do provide critical habitat information for previously undescribed portions of 

the insular shelf. One of the major assets gained in this project was the development of 

collaborations with other agencies.  These collaborations allowed for the collection of data that 

otherwise would have been out of the scope of this projects ability.  Collaborations with the US 

EPA allowed for the collection of side scan sonar data over a large area along the outer shelf 

platform (survey areas stj9a to stj12b).   Further, through collaborations with NOAA/NOS, high 

resolution bathymetric data was collected along large portions of the shelf platform and shelf 

edge south of St. Thomas and St. John.  This information, when available, can be combined with 

the side scan sonar data to provide additional coverage.  Maintenance of these collaborations 

may provide opportunity to map additional areas in the future.   
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Through the efforts to maintain conformity to existing habitat classifications, all existing habitat 

maps (Kendall et al. 2001, Geophysics GPR International 2003, Prada Triana 2003) and those 

produced in this study may be used in conjunction with each other to provide a broader 

description of the habitats in the US Virgin Islands.  Some interpretation may be necessary to 

accommodate definition differences.   

 

Through the combination of side scan sonar and multibeam technology, high resolution digital 

habitat maps were created.  However, the images from both the multibeam and side scan sonar 

will allow for further dividing the classification of the rhodolith/macroalgae habitat category.  As 

outlined in Table 6 and Figures 5 to 6, differences in community structure with in the rhodoliths 

and macroalgae habitat classification may be derived at small scales.  Although these divisions 

were not practical at the scales that the maps were drawn, the habitats as described in Table 6 

may be delineated for study specific purposes.  Figures 5 to 6 provide strong examples of sonar 

imagery and habitat for delineation purposes.   

 

Although a considerable amount of ground truthing was conducted to produce these habitat 

maps, not every feature was validated.  Additionally, some features, particularly in survey areas 

stj11a and stj11b, as explained above in section 6.0, contain complex habitats with indiscriminate 

boundaries.  These areas are still in need of ground validation and should be investigated.  The 

complex scattered coral and rock habitat illustrated in Figure 13 and Map 9 of Attachment 3 also 

require ground validation and describing.  Finally, an accuracy assessment was not conducted for 

these habitat maps. Accuracy assessment assures the user some level of confidence in the habitat 

classifications (i.e. what percent of the time was habitat ‘A’ correctly identified).  Accuracy 

assessments can be conducted using a drop video camera.  Random points within specific habitat 

units should be identified and the coordinates for those points determined.  The drop video 

camera should be deployed at those coordinates (provided on CD in accuracy assessment points 

folder) and the habitat, using the classification scheme presented in this report, be recorded.  The 

results of such surveys can be analyzed using non-parametric statistics and compared against 

random classification.  Such analysis would allow for the establishment of a level of confidence 

in the habitat classification of polygons.  

 

 

7.1 Future work 
The areas surveyed during this project are discontiguous resulting in a significant gap in data.  

Additionally, only a small portion of the areas that were surveyed lie along the shelf edge.  This 

zone is increasingly becoming recognized as possibly containing critical spawning aggregation 

habitat.  Many shelf edge coral reefs are multispecific spawning aggregation sites.  Since such a 

small area along the shelf edge has been described, continuation of identifying habitats along the 

shelf edge is paramount.  The collaborations established in recent years should be maintained 

and opportunities to collect remote sensing data through other agencies or entities should be 

considered. 

 

The next logical step in integrating the habitat maps produce here is to use this information to 

assess the current condition of the various habitats.  This project initiated steps towards that end 

with the quantitative community composition assessments provided in Tables 2 and 3.  Surveys 

such as these may provide a first step towards assessing the condition of certain habitats.  In 



F-7: Recreational Fisheries Habitat Assessment Project 

Study 4: Mapping Essential Fish Habitat with Side Scan Sonar Final Report 

Period: FY 2001-FY2005 

 

 

14 

addition to the basic species composition assessments, species health should be monitored, 

particularly in light of increasing coastal development and ocean climate change.   

 

In addition to the above, fish and invertebrate assessment should be conducted across a wide 

range of the habitats contained in these maps.  Coupling the spatial and quantitative habitat 

information presented in these habitat maps with an assessment of the fish communities will 

allow managers to develop better carrying capacity, stock abundance, and resource distribution 

models.   
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Study 4: Mapping Essential Fish Habitat with Side Scan Sonar
Period: FY 2001-FY2005

Table 1. Ground truthing coordinates and habitat at each point.  The columns labeled type and descriptor describe
the structure and make-up of each site.  

DATE_ X Y HABITAT CATEGORY TYPE DESCRIPTOR
4/30/2003 -64.65691 18.25017 coral reef linear reef deep water
4/30/2003 -64.66065 18.24725 coral reef linear reef deep water
4/30/2003 -64.64530 18.26585 colonized hardbottom colonized pavement
4/30/2003 -64.66256 18.22458 colonized hardbottom colonized pavement shelf edge
5/15/2003 -64.78197 18.30958 rhodoliths/ macroalgae rhodoliths+macroalgae dense <30% sponges
5/15/2003 -64.77953 18.31063 colonized hardbottom colonized bedrock <30% coverage
5/15/2003 -64.77545 18.31497 seagrass patchy syringodium
5/15/2003 -64.77599 18.31481 seagrass patchy syringodium
6/18/2003 -64.78035 18.30951 small boat boat
1/9/2004 -64.78243 18.30483 colonized hardbottom colonized pavement
1/9/2004 -64.76740 18.23506 coral reef linear reef <30% live
1/9/2004 -64.76768 18.23498 coral reef linear reef <30% live
1/9/2004 -64.76903 18.23493 scattered coral/ rock scattered coral/ rock
1/9/2004 -64.76912 18.23493 scattered coral/ rock scattered coral/ rock
1/9/2004 -64.74023 18.23080 rhodoliths/ macroalgae rhodoliths+macroalgae sparse
1/9/2004 -64.74083 18.23068 rhodoliths/ macroalgae rhodoliths+macroalgae sparse
1/9/2004 -64.73985 18.23078 rhodoliths/ macroalgae rhodoliths+macroalgae sparse
1/9/2004 -64.75315 18.24345 coral reef linear reef deep water
1/9/2004 -64.75370 18.24347 coral reef linear reef deep water
1/9/2004 -64.75377 18.24347 coral reef linear reef deep water
1/9/2004 -64.75348 18.24347 coral reef linear reef deep water
3/25/2004 -64.78043 18.30470 rhodoliths/ macroalgae rhodoliths+macroalgae w/ sponges <30% sponges
3/25/2004 -64.78421 18.30465 colonized hardbottom colonized pavement >70% coverage
3/25/2004 -64.78518 18.30433 colonized hardbottom colonized pavement <30% coverage
3/25/2004 -64.78590 18.30325 rhodoliths/ macroalgae rhodoliths+macroalgae
3/25/2004 -64.78660 18.30321 colonized hardbottom colonized pavement w/ sand veneer
3/25/2004 -64.78661 18.30361 colonized hardbottom colonized pavement w/ sand veneer <30% coverage
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Table 1 cont'd. Ground truthing coordinates and habitat at each point.  The columns labeled type and descriptor describe
the structure and make-up of each site.  

DATE_ X Y HABITAT CATEGORY TYPE DESCRIPTOR
3/25/2004 -64.78670 18.30376 colonized hardbottom colonized pavement w/ sand veneer <10%
3/25/2004 -64.78713 18.30433 colonized hardbottom colonized pavement w/ sand veneer 10-30% sc
4/2/2004 -64.78413 18.30728 rhodoliths/ macroalgae rhodoliths+macroalgae dense
4/2/2004 -64.78560 18.30736 rhodoliths/ macroalgae rhodoliths+macroalgae moderate <10%
4/2/2004 -64.78573 18.30665 colonized hardbottom colonized pavement w/ sand veneer
4/2/2004 -64.78580 18.30601 colonized hardbottom colonized pavement <30%
4/2/2004 -64.77466 18.30663 rhodoliths/ macroalgae rhodoliths+macroalgae dense 50-70%
4/2/2004 -64.77583 18.30628 rhodoliths/ macroalgae rhodoliths+macroalgae dense 30-50%
4/2/2004 -64.77496 18.30550 rhodoliths/ macroalgae rhodoliths+macroalgae dense 70%
7/19/2004 -64.79280 18.26760 colonized hardbottom colonized pavement 70%
7/19/2004 -64.67720 18.33800 coral reef patch reef 70% live
7/19/2004 -64.76790 18.27500 colonized hardbottom colonized pavement 70% live
7/20/2004 -64.74860 18.27500 colonized hardbottom colonized pavement w/ sand c
7/20/2004 -64.72550 18.26980 coral reef linear reef 70% live
7/21/2004 -64.79780 18.26480 colonized hardbottom colonized pavement 50% live
7/21/2004 -64.82357 18.24958 coral reef spur and groove 50% live
7/21/2004 -64.82240 18.24870 coral reef spur and groove w/ sand c
8/18/2004 -64.77564 18.30117 rhodoliths/ macroalgae rhodoliths+macroalgae dense w/ sand c
8/18/2004 -64.77602 18.30093 rhodoliths/ macroalgae rhodoliths+macroalgae dense 50%
8/18/2004 -64.77650 18.30106 rhodoliths/ macroalgae rhodoliths+macroalgae dense <30% sponges
8/18/2004 -64.77616 18.30402 rhodoliths/ macroalgae rhodoliths+macroalgae sparse <30% sponges
8/18/2004 -64.77648 18.30413 rhodoliths/ macroalgae rhodoliths+macroalgae sparse <30% sponges
8/18/2004 -64.77712 18.30466 rhodoliths/ macroalgae rhodoliths+macroalgae sparse <30% sponges
8/18/2004 -64.75716 18.24423 coral reef linear reef deep water
2/24/2005 -64.75228 18.29810 rhodoliths/ macroalgae macroalgae sparse 30-50% ma
2/24/2005 -64.75170 18.29743 sand sand <10%
2/24/2005 -64.75093 18.29728 scattered coral/ rock scattered coral/ rock 10-30% sc
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Table 1 cont'd. Ground truthing coordinates and habitat at each point.  The columns labeled type and descriptor describe
the structure and make-up of each site.  

DATE_ X Y HABITAT CATEGORY TYPE DESCRIPTOR
2/24/2005 -64.73491 18.30348 coral reef patch reef aggregate
2/24/2005 -64.73527 18.30375 sand sparse ma <10%
2/24/2005 -64.73575 18.30422 coral reef patch reef aggregate
2/24/2005 -64.73598 18.30428 rhodoliths/ macroalgae sparse ma <30%
2/24/2005 -64.73797 18.30857 coral reef spur groove 50-70%
2/24/2005 -64.75220 18.29938 rhodoliths/ macroalgae macroalgae 30-50%
2/24/2005 -64.75197 18.29963 coral reef patch reef aggregate 70%
2/24/2005 -64.75172 18.29960 coral reef patch reef aggregate 70%
3/3/2005 -64.74599 18.30361 coral reef patch reef individual 70% live
3/3/2005 -64.74636 18.30421 coral reef patch reef individual 70% live
3/3/2005 -64.74672 18.30652 rhodoliths/ macroalgae rhodoliths+macroalgae sparse w/ sand c
3/3/2005 -64.74809 18.29961 coral reef patch reef individual 70% live
3/3/2005 -64.74735 18.30027 coral reef patch reef individual 50% live
3/3/2005 -64.74716 18.30106 coral reef patch reef individual 50% live
3/3/2005 -64.74687 18.30188 rhodoliths/ macroalgae rhodoliths+macroalgae sparse w/ sand c
3/3/2005 -64.74686 18.30224 rhodoliths/ macroalgae rhodoliths+macroalgae sparse w/ sand c
3/3/2005 -64.73753 18.31112 coral reef spur groove 50%
4/12/2005 -64.75946 18.29308 rhodoliths/ macroalgae macroalgae patchy <30%
4/12/2005 -64.75915 18.29295 boat decomposed boat
4/12/2005 -64.75896 18.29285 boat decomposed boat
4/12/2005 -64.75886 18.29282 colonized hardbotto colonized pavement
4/12/2005 -64.76041 18.29299 rhodoliths/ macroalgae macroalgae patchy 30-50%
4/12/2005 -64.76061 18.29354 rhodoliths/ macroalgae macroalgae patchy 50-70%
4/12/2005 -64.76885 18.29832 rhodoliths/ macroalgae macroalgae patchy >70%
4/12/2005 -64.76746 18.29840 rhodoliths/ macroalgae macroalgae patchy <10%
4/12/2005 -64.75694 18.30062 rhodoliths/ macroalgae macroalgae patchy <30%
4/12/2005 -64.75709 18.30072 rhodoliths/ macroalgae macroalgae continuous
4/12/2005 -64.75775 18.30104 rhodoliths/ macroalgae macroalgae continuous
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Table 2. Results of the community composition, 30m photo transects conducted on the side scan sonar reef (stj9b-stj10a).  

Side-scan sonar reef 18o14.6538  64o45.4296 18.24423 -64.75716 Diversity index summary table
8/18/2004 NUMBERS REPRESENT PERCENT OF TRANSECT *This sums all the points per species of all transects to calculate the H'.

Transect Length 30m category sum for each transect category sum for each transec
CATEGORY 1 2 3 mean (SD) CATEGORY Categories total pts. (ni /N)(ln ni /N) Categories total pts. (ni /N)(ln ni /N)
CORAL 53.5 52.9 54.8 53.8 1.0 CORAL Acropora cervicornis (AC) - coral 0 0.00 Porites astreoides (PA) - coral 22 0.36
GORGONIANS 0.0 0.3 0.0 0.1 0.2 GORGONIANS Acropora palmata (AP) - coral 0 0.00 Porites branneri (PB) - coral 0 0.00
SPONGES 1.9 1.3 2.3 1.8 0.5 SPONGES Acropora prolifera (APR) - coral 0 0.00 Porites divaricata (PD) - coral 1 0.06
ZOANTHIDS 0.0 0.0 0.0 0.0 0.0 ZOANTHIDS Agaricia agaricites (AA) - coral 10 0.28 Porites furcata (PF) - coral 4 0.17
MACROALGAE 34.5 37.1 35.8 35.8 1.3 MACROALGAE Agaricia fragilis (AF) - coral 0 0.00 Porites porites (PP) - coral 0 0.00
COALLINE ALGAE 0.0 0.0 0.0 0.0 0.0 COALLINE ALGAE Agaricia grahamae (AG) - coral 0 0.00 Scolymia cubensis (SC) - coral 0 0.00
DEAD CORAL w/ TURF ALGAE 8.4 7.7 5.5 7.2 1.5 DEAD CORAL w/ TURF ALGAE Agaricia humilis (AH) - coral 0 0.00 Scolymia lacera (SL) - coral 0 0.00
DISEASED CORALS 0.0 0.0 0.0 0.0 0.0 DISEASED CORALS Agaricia lamarcki (AL) - coral 0 0.00 Siderastrea radians (SR) - coral 0 0.00
SAND, RUBBLE, PAVEMENT 1.3 0.3 1.3 1.0 0.6 SAND, RUBBLE, PAVEMENT Agaricia tenuifolia (AT) - coral 0 0.00 Siderastrea siderea (SS) - coral 4 0.17
OTHER, LIVE 0.3 0.3 0.3 0.3 0.0 OTHER, LIVE Agaricia undata (AU) - coral 0 0.00 Solenastrea bournoni (SB) - coral 0 0.00
UNKNOWNS 0.0 0.0 0.0 0.0 0.0 UNKNOWNS Colpophyllia natans (CN) - coral 5 0.19 Solenastrea hyades (SH) - coral 0 0.00
TAPE + WAND + SHADOW 0.0 0.0 0.0 0.00 0.00 TAPE + WAND + SHADOW Dendrogyra cylindrus (DCY) - coral 0 0.00 Stephanocoenia michelinii (SM) - coral 0 0.00
SHANNON WEAVER DIV. INDEX 1.80 1.97 1.81 2.19 H', using sums of all transects (see right) Diploria clivosa (DC) - coral 0 0.00 Tubastraea aurea (TA) - coral 0 0.00

-9.26 H', including MACX as species in sum of trans. Diploria labyrinthiformis (DL) - coral 0 0.00 Millepora alcicornis (MILA) - coral 1 0.06
NUMBERS OF POINTS PER TRANSECT Diploria strigosa (DS) - coral 5 0.19 Millepora complanata (MILC) - coral 0 0.00

CATEGORY 1 2 3 sums CATEGORY Dichocoenia stokesii (DSO) - coral 0 0.00 Millepora squarrosa (MILS) - coral 0 0.00
CORAL 166 164 170 500 CORAL Eusmilia fastigiata (EF) - coral 1 0.06
GORGONIANS 0 1 0 1 GORGONIANS Favia fragum (FF) - coral 0 0.00 H'=
SPONGES 6 4 7 17 SPONGES Isophyllia sinuosa (IS) - coral 0 0.00 # corals of known species 69 2.19
ZOANTHIDS 0 0 0 0 ZOANTHIDS Isopyhyllastrea rigida (IR) - coral 0 0.00 check of # corals of known species 69
MACROALGAE 107 115 111 333 MACROALGAE Leptoseris cucullata (LC) - coral 0 0.00 total number of coral points 500
COALLINE ALGAE 0 0 0 0 COALLINE ALGAE Manicina areolata (MAR) - coral 0 0.00 (includes un-identifiable species)
DEAD CORAL w/ TURF ALGAE 26 24 17 67 DEAD CORAL w/ TURF ALGAE Madracis decactis (MD) - coral 0 0.00 percent of coral species un-identifiable 86.20
DISEASED CORALS 0 0 0 0 DISEASED CORALS Madracis formosa (MAFO) - coral 1 0.06
SAND, RUBBLE, PAVEMENT 4 1 4 9 SAND, RUBBLE, PAVEMENT Madracis mirabilis (MM) - coral 0 0.00 Including MACX in MA Category H'=
OTHER, LIVE 1 1 1 3 OTHER, LIVE Meandrina meandrites (MME) - coral 1 0.06 # corals of known species 500 -9.26
UNKNOWNS 0 0 0 0 UNKNOWNS Montastraea annularis (MA) - coral 0 0.00 total number of coral points 500
TAPE + WAND + SHADOW 0 0 0 0 TAPE + WAND + SHADOW Montastraea cavernosa (MC) - coral 9 0.27 percent of coral points identified to spp. 100.00
t+w+s, not incl. in sums Montastraea faveolata (MFAV) - coral 0 0.00
Sum of Points per transect 310 310 310 930 Montastraea franksi (MFRA) - coral 0 0.00

Mussa angulosa (MAN) - coral 0 0.00
Corals: 53.5483871 52.903226 54.83871 53.76 0.99 Mycetophyllia aliciae (MAL) - coral 0 0.00
Branching 0 0 0 0.00 0.00 Mycetophyllia danaana (MDA) - coral 1 0.06
Lettuce 0 0 0 0.00 0.00 Mycetophyllia lamarckiana (ML) - coral 1 0.06
Finger 0 0.6451613 0.6451613 0.43 0.37 Mycetophyllia ferox (MF) - coral 3 0.14
Plate/Sheet 0.96774194 0.9677419 1.2903226 1.08 0.19 Oculina diffusa (OD) - coral 0 0.00
Boulder/Mound 52.2580645 50.967742 52.903226 52.04 0.99
Cup/Flower 0.32258065 0 0 0.11 0.19 Montastraea annularis complex (MACX) 431 -11.44
Bush 0 0 0 0.00 0.00
Fire corals 0 0.3225806 0 0.11 0.19 Including MACX as MA 431 -11.44

Ball sponge 0.00 0.00 0.00 0.00 0.00
Barrel/Vase sponge 1.29 0.00 0.65 0.65 0.65
Boring sponge 0.00 0.00 0.00 0.00 0.00
Encrusting sponge 0.65 0.65 0.97 0.75 0.19
Rope spone 0.00 0.32 0.65 0.32 0.32
Tube sponge 0.00 0.32 0.00 0.11 0.19

Boulder 0.00 0.00 0.00 0.00 0.00
Sand/Sediment 1.29 0.32 1.29 0.97 0.56
Rubble 0.00 0.00 0.00 0.00 0.00
Pavement 0.00 0.00 0.00 0.00 0.00

Data and summary provided by Liz Whiteman, U.E.A. 23



F-7: Recreational Fisheries Habitat Assessment Project
Study 4: Mapping Essential Fish Habitat with Side Scan Sonar
Period: FY 2001-FY2005

ect

Data and summary provided by Liz Whiteman, U.E.A. 24



F-7: Recreational Fisheries Habitat Assessment Project
Study 4: Mapping Essential Fish Habitat with Side Scan Sonar
Period: FY 2001-FY2005

v
m

a

n

E s

s
g

u

o

m
a
e
a
c
f
f
o

a

C

Table 3. Results of the community composition, 30m transect surveys for a spur and groove reef in survey area stj2a.

NUMBERS REPRESENT PERCENT OF TRANSECT Diversity index summary table
1/0/1900 NUMBERS REPRESENT PERCENT OF TRANSECT *This sums all the points per species of all transects to calculate the H'.

Transect Length 30 category sum for each transect category sum for each transect
CATEGORY 1 5 7 5 3 mean (SD) CATEGORY Categories total pts. (ni /N)(ln ni /N) Categories total pts. (ni /N)(ln ni /N)
CORAL 0.0 0.0 0.0 0.0 0.0 0.0 0.0 CORAL Acropora cer 7 0.31 Porites astreoides (PA) - coral 54 -0.50
GORGONIANS 35.2 31.0 33.5 30.0 41.0 34.1 4.3 GORGONIANS Acropora pal 0 0.00 Porites branneri (PB) - coral 0 0.00
SPONGES 1.3 3.5 1.0 0.0 0.0 1.2 1.5 SPONGES Acropora proli 0 0.00 Porites divaricata (PD) - coral 0 0.00
ZOANTHIDS 16.1 19.4 20.6 18.1 21.3 19.1 2.1 ZOANTHIDS Agaricia agari 0 0.00 Porites furcata (PF) - coral 0 0.00
MACROALGAE 0.0 0.0 0.0 0.0 0.0 0.0 0.0 MACROALGAE Agaricia fragil 8 0.33 Porites porites (PP) - coral 0 0.00
COALLINE ALGAE 9.7 2.6 2.9 1.0 4.3 4.1 3.3 COALLINE ALGAE Agaricia grah 0 0.00 Scolymia cubensis (SC) - coral 0 0.00
DEAD CORAL w/ TURF ALGAE 0.3 1.6 0.0 0.0 0.0 0.4 0.7 DEAD CORAL w/ TURF ALGAE Agaricia humi 0 0.00 Scolymia lacera (SL) - coral 9 0.34
DISEASED CORALS 0.0 0.0 0.0 0.0 0.0 0.0 0.0 DISEASED CORALS Agaricia lama 0 0.00 Siderastrea radians (SR) - coral 0 0.00
SAND, RUBBLE, PAVEMENT 0.0 0.0 0.0 0.0 0.0 0.0 0.0 SAND, RUBBLE, PAVEMENT Agaricia tenuif 41 -0.08 Siderastrea siderea (SS) - coral 0 0.00
OTHER, LIVE 0.0 0.0 0.0 0.0 0.0 0.0 0.0 OTHER, LIVE Agaricia unda 3 0.20 Solenastrea bournoni (SB) - coral 0 0.00
UNKNOWNS 0.0 0.0 0.0 0.0 0.0 0.0 0.0 UNKNOWNS Colpophyllia 8 0.33 Solenastrea hyades (SH) - coral 5 0.27
TAPE + WAND + SHADOW 0.0 0.0 0.0 0.0 0.0 0.00 0.00 TAPE + WAND + SHADOW Dendrogyra cy 1 0.10 Stephanocoenia michelinii (SM) - coral 0 0.00
SHANNON WEAVER DIV. INDEX SENT POINTS 0.00 0.00 0.00 0.00 -15.37 H', using sums of all transects (see right) Diploria clivo 1 0.10 Tubastraea aurea (TA) - coral 0 0.00

-15.37 H', including MACX as species in sum of trans. Diploria labyri 0 0.00 Millepora alcicornis (MILA) - coral 0 0.00
NUMBERS OF POINTS PER TRANSECT Diploria strigo 0 0.00 Millepora complanata (MILC) - coral 0 0.00

CATEGORY 0.96774194 4.83870968 7.41935484 4.83870968 3 sums CATEGORY Dichocoenia 0 0.00 Millepora squarrosa (MILS) - coral 38 0.00
CORAL 0 0 0 0 0 0 CORAL Eusmilia fasti 0 0.00
GORGONIANS 109 96 104 93 123 525 GORGONIANS Favia fragum 0 0.00 H'=
SPONGES 4 11 3 0 0 18 SPONGES Isophyllia sin 0 0.00 # corals of known species 0 -15.37
ZOANTHIDS 50 60 64 56 64 294 ZOANTHIDS Isopyhyllastre 0 0.00 check of # corals of known species 535
MACROALGAE 0 0 0 0 0 0 MACROALGAE Leptoseris cuc 0 0.00 total number of coral points -15
COALLINE ALGAE 30 8 9 3 13 63 COALLINE ALGAE Manicina are 0 0.00 (includes un-identifiable species)
DEAD CORAL w/ TURF ALGAE 1 5 0 0 0 6 DEAD CORAL w/ TURF ALGAE Madracis deca 1 0.10 percent of coral species un-identifiable 3579.95
DISEASED CORALS 0 0 0 0 0 0 DISEASED CORALS Madracis for 313 -17.37
SAND, RUBBLE, PAVEMENT 0 0 0 0 0 0 SAND, RUBBLE, PAVEMENT Madracis mir 0 0.00 Including MACX in MA Category H'=
OTHER, LIVE 0 0 0 0 0 0 OTHER, LIVE Meandrina m 32 0.14 # corals of known species 535 -15.37
UNKNOWNS 0 0 0 0 0 0 UNKNOWNS Montastraea 0 0.00 total number of coral points -15
TAPE + WAND + SHADOW 0 0 0 0 0 0 TAPE + WAND + SHADOW Montastraea 0 0.00 percent of coral points identified to spp. -3479.95
t+w+s, not incl. in sums Montastraea 0 0.00
Sum of Points per transect 194 180 180 152 200 906 Montastraea 0 0.00

Mussa angul 0 0.00
Data provided by E. A. Whiteman, UEA Mycetophyllia 0 0.00
 Mycetophyllia 0 0.00

Mycetophyllia 0 0.00
Mycetophyllia 14 0.37
Oculina diffusa 0 0.00

Montastraea 0 0.00

Including MA 0 0.00

Data and summary provided by E.A. Whiteman, U.E.A. 24
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Table 4. Structure of NOAA’s classification scheme 
Zone 
Habitat 
 Third level (structural description) 
  Fourth level (level of cover) 
 
*Zones: 
Land, Shoreline Intertidal, Lagoon, Back Reef, Reef Crest, Fore Reef, Bank/ Shelf, Bank/ 
Shelf Escarpment, Unknown 
Habitats: 
Unconsolidate Sediments 
 Sand 
 Mud 
Submerged Vegetation 
 Seagrass 
  Continuous 
  Patchy (4 subcategories) 
 Macroalgae 
  Continuous 
  Patchy (2 subcategories) 
Coral Reef and Hardbottom 
 Coral Reef and Colonized Hardbottom 
  Linear Reef 
  Spur and Groove 
  Individual Patch Reef 
  Aggregated Patch Reefs 
  Scattered coral/Rock in Unconsolidated Sediment 
  Colonized Pavement 
  Colonized Bedrock 
  Colonized Pavement with Sand Channels 
 Uncolonized Hardbottom 
  Reef Rubble 
  Uncolonized Pavement 
  Uncolonized Bedrock 
  Uncolonized Pavement with Sand Channels 
Other 
 Land 
 Mangroves 
 Artificial 
 Unknown 
 
* Redrawn from Kendall (2001).   
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Table 5. Habitat classification scheme as presented in Prada Triana (2003). 

Meta-community  Community Sub-community Habitat types  Habitat 
Codes  

coral high relief 
Continuous 
Corals COCO 

coral patch Coral Patch COPA 

coral low relief 
Coral 
Limestone COLI 

corals 

gorgonian patch 
Gorgonian 
Patch GOPA 

plains 
Gorgonian 
Plains GOPL 

Coral and gorgonians 
on consolidated 

sediments 

gorgonians 

elevated plains 
Elevated 
Gorgonians ELGO 
Dense Grass DEGR 
Sparse Grass SPGR 
Grass-
Invertebrates GRIN seagrass Seagrass 

Grass Halo & 
Coral Patch HALO 
Dense Algae DEAL 
Sparse Algae SPAL algae on sand 
Algae & 
Invertebrates ALIN 
Shallow 
Algae SHAL 

Submerged Aquatic 
Vegetation (SAV) on 

unconsolidated 
sediments 

macro-
algae 

algae on silt 
Deep Algae DEEP 
Sand 
Invertebrates SAIN 
Sand no 
Ripple SANR 

coarse sand 

Sand Ripple SARI 

sand 

fine sand Fine Sand FIMU 
Mud-
Invertebrates MUIN 
Mud Bare MUBA 

Bare or mixed invertebrates
on unconsolidated 
sediments 

silt mud 

Mud Reef MURE 
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Table 6. Habitat classification scheme used in this project.  Italics indicate categories that are discernable at small scales but were not 
classified in this project.  The bold text descriptions that are included in the reef and hardbottom layer only. 
Zone Broad Habitat Habitat Category Desc_1 Form 
Bank Shelf Unconlsolidated 

Sediment 
Sand    

Midshelf 
Ridge 

 Coral Rubble    

Shelf 
Platform 

Submerged Vegetation Seagrass Dense   

Shelf Edge   Sparse   
  Rhodoliths/ Macroalgae Rhodoliths with Macroalgae   
   Rhodoliths no Macroalgae   
   Rhodoliths with Sand Channels   
   Macroalgae no Rhodoliths   
 Reef and Hardbottom Coral Reef Spur and Groove  Shallow coral
     Plating coral 
   Patch Reef Aggregate Shallow coral
     Plating coral 
    Individual Shallow coral
     Plating coral 
   Linear Reef  Shallow coral
     Plating coral 
   Bank Reef  Shallow coral
     Plating coral 
  Colonized Hardbottom Colonized Bedrock   
   Colonized Pavement   
    Gorgonian Patch  
  Scattered coral/ rock  With Rhodoliths  
    With Coral Heads  
 Artificial Boat    
  Debris    
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Table 7. List of polygons that were either adjusted or drawn using the multibeam 
data (NCCOS 2004, 2005).  The columns refer to columns in the attribute table. 
 The column Id refers to the polygon Idand the adj_mbeam identifies what adjustmetn was made.  
Id habitat category desc_1 adj_mbeam
8 coral reef patch reef individual drawn
9 coral reef patch reef individual drawn
16 coral reef patch reef aggregate shifted
17 coral reef patch reef aggregate adjusted edge
18 coral reef patch reef aggregate adjusted edge
19 coral reef patch reef aggregate adjusted edge
20 coral reef patch reef aggregate adjusted edge
21 coral reef patch reef aggregate shifted
24 coral reef patch reef aggregate drawn
25 coral reef patch reef aggregate shifted
26 coral reef patch reef aggregate shifted
27 coral reef patch reef aggregate shifted
28 coral reef patch reef aggregate shifted
29 coral reef patch reef aggregate drawn
30 coral reef patch reef aggregate adjusted edge
31 coral reef patch reef aggregate adjusted edge
32 coral reef patch reef aggregate adjusted edge
33 coral reef patch reef aggregate drawn
34 coral reef patch reef aggregate drawn
35 coral reef patch reef aggregate drawn
36 coral reef patch reef aggregate drawn
37 coral reef patch reef aggregate drawn
38 coral reef patch reef aggregate drawn
39 coral reef patch reef aggregate drawn
40 coral reef patch reef aggregate drawn
42 coral reef patch reef individual drawn
43 coral reef patch reef aggregate shifted
44 coral reef patch reef aggregate shifted
45 coral reef patch reef aggregate shifted
46 coral reef patch reef aggregate shifted
47 colonized hardbottom colonized pavement shifted
48 colonized hardbottom colonized pavement drawn
49 coral reef patch reef aggregate shifted
50 coral reef patch reef aggregate shifted
51 colonized hardbottom colonized pavement shifted
57 colonized hardbottom colonized pavement shifted
58 colonized hardbottom colonized pavement shifted
59 colonized hardbottom colonized pavement shifted
60 coral reef patch reef aggregate shifted
61 coral reef patch reef aggregate adjusted edge
64 coral reef patch reef aggregate shifted
65 coral reef patch reef aggregate drawn
66 coral reef patch reef aggregate shifted
67 coral reef patch reef aggregate shifted
68 coral reef patch reef aggregate shifted
71 coral reef patch reef aggregate shifted
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Table 7 cont'd. List of polygons that were either adjusted or drawn using the multibeam 
data (NCCOS 2004, 2005).  The columns refer to columns in the attribute table. 
 The column Id refers to the polygon Idand the adj_mbeam identifies what adjustmetn was made.  
Id habitat category desc_1 adj_mbeam
72 coral reef patch reef aggregate shifted
76 coral reef patch reef aggregate shifted
89 colonized hardbottom colonized pavement shifted
101 coral reef patch reef aggregate shifted
104 colonized hardbottom colonized pavement shifted
111 coral reef patch reef aggregate shifted
112 coral reef patch reef aggregate shifted
113 coral reef patch reef aggregate shifted
114 coral reef patch reef aggregate shifted
116 coral reef patch reef aggregate shifted
117 coral reef patch reef aggregate shifted
118 coral reef patch reef aggregate shifted
166 coral reef patch reef aggregate shifted
167 coral reef patch reef aggregate shifted
170 coral reef patch reef aggregate shifted
175 coral reef patch reef aggregate shifted
176 coral reef patch reef aggregate shifted
177 coral reef patch reef aggregate shifted
178 coral reef patch reef aggregate shifted
181 coral reef patch reef aggregate shifted
182 coral reef patch reef aggregate shifted
183 colonized hardbottom colonized pavement shifted
185 coral reef patch reef aggregate shifted
186 coral reef patch reef aggregate shifted
187 colonized hardbottom colonized pavement shifted
188 coral reef patch reef aggregate shifted
199 colonized hardbottom colonized pavement shifted
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Table 8. Total area for each habitat at the different hierarchical levels of the broad habitat layer.   

Broad Habitat 
Area 
km2

Percent 
of area Habitat 

Area 
km2

Percent 
of area Category 

Area 
km2

Percent 
of area 

unconsolidated 
sediment 0.32 0.6% sand 0.32 0.6% sand 0.32 0.6%
submerged 
vegetation 40.55 77.1% seagrass 0.28 0.5% seagrass 0.28 0.5%
reef and 
hardbottom 11.75 22.3%

rhodoliths/ 
macroalgae 40.27 76.5%

rhodoliths/ 
macroalgae 40.27 76.5%

   colonized 
hardbottom 1.58 3.0%

spur and 
groove 0.15 0.3%

   coral reef 8.31 15.8% patch reef 1.00 1.9%
   scattered 

coral/ rock 1.86 3.5% linear reef 0.03 0.1%
      bank reef 7.14 13.6%
      colonized 

bedrock 0.01 0.0%
      colonized 

pavement 1.57 3.0%
      scattered 

coral/ rock 1.86 3.5%
The category for artificial structures was removed because they constitute such a small area.   
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Table 9. Total area and percent contribution of each  
habitat in the reef and hardbottom layer. 
 

Habitat 
Area 
km2

Percent 
of area 

spur and groove 0.15 1.49%

patch reef 0.27 2.75%

linear reef 0.02 0.25%

bank reef 5.49 55.95%

colonized bedrock 0.01 0.13%

colonized pavement 1.41 14.37%

scattered coral/ rock 2.47 25.10%
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Figure 1. Map of St. John depicting approximate boundaries of the Virgin Islands National Park, 
Virgin Islands Coral Reef National Monument, and area surveyed with side scan sonar
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Side scan sonar survey area with survey grids.  Shaded grids indicate survey areas 
that were completed in this project.  
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Scale 1:1000 

a.  b.  c.  

 

 

d.  e.  f.  

 

Figure 4. Ground truthing of seagrass habitats (a) side scan sonar image of dense 

seagrass patches, (b-c) notice the dense patches in the background, sparse patches in the 

foreground, and sand channels, (d) side scan sonar image of continuous seagrass 

Syringodium sp., and (e-f) sparse seagrass.   
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Scale 1:1000 

a.  b.  c.  

 

d.  e.  f.  

 

g.  h.  i.  

 

j.  k.  l.  

 

m.  n.  o.  

Figure 5. Ground truthing of rhodoliths/ macroalgae habitats on the insular shelf 

platform, (a-c) rhodoliths with little to no fleshy macroalgae, (d-f) swells and wave action 

forms ripples in the rhodoliths even at depths greater than 33m, (g-l) rhodoliths with 

fleshy macroalgae, usually Lobophora sp., produce bands of light and dark in the side 

scan sonar return, with the dark bands usually being rhodoliths with Lobophora sp. and 

the lighter areas usually contain sparse macroalgae, (m-o) the appearance of ‘holes’ in the 

side scan sonar record are indicative of areas with a dense population of infauna. 
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Scale 1:1000 

a.  b.  c.  

 

d.  e.  f.  

Figure 6. Rhodoliths communities along the outer shelf platform in deeper water 30-

50m, (a) produce a smoother texture in the side scan sonar return and (b-c) have limited 

to no fleshy macroalgae.  A rougher texture in the sonar return (d-f) is indicative of areas 

of dense rhodoliths with some small scattered stony corals.  It appears that these 

communities rarely ‘turn over’ as most rhodoliths communities therefore allowing 

encrusting and low canopy corals to recruit to them.   
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Scale 1:1000 

a.  b.  c.  

 

d.  e.  f.  

Figure 7. Patch reefs generally have distinct boundaries and rise steeply from the 

surrounding habitat (a, b, d, e), and often have scattered coral/ rock visible in the sonar 

return (a).  Patch reefs also have varying degrees of stony corals and gorgonians (b, c, e, 

f).  The above images contain examples of shallow water growth forms.   

 

 

 

 

 

 

 

 

 

 



F-7: Recreational Fisheries Habitat Assessment Project 

Study 4: Mapping Essential Fish Habitat with Side Scan Sonar 

Period: FY 2001-FY2005 

 

39 

 

 

Scale 1:1000 

a.  b.  c.  

Figure 8. Spur and groove habitats yield distinct banding in the sonar return (a), and have 

deep groove features (b, c) that orient perpendicular to the shoreline of prevailing 

currents. 
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Scale 1:1000 

a.  b.  c.  

 

d.  e.  f.  

 

g.  h.  i.  

 

j.  k.  l.  

Figure 9. Coral reefs on the outer shelf platform, south of the mid-shelf reef system, (a-i) 

and along the shelf edge (j-l) are predominately comprised of plating forms of Agaricia 

spp. and Montastraea spp.  On these deeper reefs the transition from sand or rhodoliths to 

coral reef (a-c) is often difficult to discern as no discrete boundary exists.  However, the 

arrow in (a) probably indicates the sand to coral interface.   
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Scale 1:1000 

a.  b.  c.  

Figure 10.  Colonized bedrock appears as large features (a), and is comprised of boulders 

or shoreline features and can be covered with corals, gorgonians, macroalgae, and/ or 

sponges (b, c).   
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Scale 1:1000 

a.  b.  c.  

 

d.  e.  f.  

 

g.  h.  i.  

Figure 11. Colonized pavement has numerous side scan sonar returns that appear to 

correspond to position on the shelf platform, substrate topology, and the overlying 

invertebrates.  Along the bank shelf spur and groove features are apparent (a-c) but have 

a smoother appearance than coral reef spur and groove.  Across the plateau, also often 

referred to as gorgonian plains or hardgrounds, the sonar image appears flatter and has a 

grainy texture (d, g).  Along this region a sand veneer covers portions of the limestone 

substrate which is colonized by large sponges, gorgonians and sparse corals (e, f, h, i). 
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Scale 1:1000 

j.  k.  l.  

 

m.  n.  o.  

Figure 11 cont’d. Colonized pavement along the mid-shelf ridge appears as linear reef or 

again as spur and groove (j-l).  Further out along the shelf edge the sonar return appears 

flatter with eroded edges.  Here it is difficult to discriminate between colonized pavement 

habitats and rhodoliths habitats (m).  On the colonized pavement gorgonians are often 

sparse (n, o).   
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Scale 1:1000 

   
Figure 12. An additional habitat along the outer shelf platform is similar to both 

colonized pavement and scattered rock (a-c).  This habitat consists of limestone substrate 

that appears to be dead coral and has some gorgonian growth with little stony coral 

growth.  This habitat has been classified in this project as scattered coral/ rock.   
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Figure 13. Example of (a) scattered coral/ rock (red square) in which  the final polygon 

was drawn around the entire habitat but (b) individual features within that habitat could 

be larger than the MMU of 50m
2
 (yellow circle).   

 

a. b. 
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Figure 14. Polygons were created using the side scan sonar images (blue line) and then 

shifted to match the positioning of the multibeam (red line).  The multibeam is clearly 

visible, as the colored features, through the side scan sonar imagery, grey shading.   
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Figure 15. Differences between the bank reef in stj11a and stj11b at (a) the broad habitat 

scale and (b) the smaller scale of the reef and hardbottom layer.  Notice that in some 

cases the habitat of certain polygons in the smaller scale layer changed from that of the 

broader scale layer.  The large yellow polygon in (b) is classified as scattered coral/ rock 

in the smaller scale layer and (a) is included in the bank reef in the larger scale layer.   

 

 

a. b. 
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Figure 16. Total area (km

2
) of each habitat in the broad habitat layer.  The artificial reef 

category has been omitted as it contributed less than 0.01km
2
.   
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Figure 17. The average area (km

2
) of polygons drawn for each habitat type in the broad 

habitat layer.  Again artificial reefs have been removed.  
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Figure 18. The total area (km

2
) of each habitat in the reef and hardbottom layer. 
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Figure 19. The average area (km

2
) of polygons drawn for each habitat in the reef and 

hardbottom layer.   
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Procedures for side scan sonar acquisition 
 

Equipment Setup 
1. install WAAS GPS and primary depth sounder 
2. Place the computer tower “acquisition computer” in the mounts under the 

Lindsay’s cabin 
3. place a battery back-ups in the cabin as well and plug it into the power inverter 
4. plug the acquisition computer tower into the UPS 
5. set the navigation laptop in the platform above the steering for the Lindsay 

a. Install the hardlock key into the printer port on the back of the laptop 
(Note: the navigation software will not run without this adapter) 

b. connect the power cord to the UPS 
c. connect one end of the split NMEA connection (serial cord labeled 

“NMEA connection”) to the laptop and one end to the wires hanging down 
from the GPS unit 

d. the other end of the NMEA connection goes into serial port 1 on the data 
acquisition computer, this end is labeled “to tower” 

6. mount the flat screen monitor in the ball and joint mount by the passenger seat on 
the port side of the cockpit.  The flat screen is powered by 12volts and connects to 
the 2pin connector in front of the ledge.  The monitor cable runs down to the data 
acquisition computer.   

7. Data acquisition computer – connect the monitor, connect the mouse, connect the 
keyboard (Note: there is a new wireless keyboard and mouse in the SSS office for 
the new tower) make sure the NMEA connector is connected as described above, 
connect the small black wire that runs alongside the power inverter to the 
grounding bolt in the back of the tower.   

8. Connect the deck cable into the pigtail that runs out of the base of the tower 
9. connect the wet end of the towcable to the towfish (it is advised to spray a little 

WD40 on and into the towfish connector) also be sure to connect the braided 
harness on the cable to the stainless steel safety wire.  Run the cable throught the 
sheave block assembly. 

10. Power on the inverter and UPS and all computers 
 
 
Navigation Laptop 
1. start HypackMax 
2. click on survey and select survey a new screen starts with several windows open 
3. to test the NMEA connection restore the nmea window at the bottom, it should 

scroll lat and long data 
4. go to line and select select file now navigate to select the file that you want to 

survey 
5. This will display the lines to be surveyed and the boat on the map window (if you 

are not near the survey area the distance may be to great to show both the position 
of the boat and the survey area – hitting ‘ctrl+’ or ‘ctrl-‘ will zoom or unzoom 
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Table 1 cont'd. Ground truthing coordinates and habitat at each point.  The columns labeled type and descriptor describe
the structure and make-up of each site.  

DATE_ X Y HABITAT CATEGORY TYPE DESCRIPTOR
3/25/2004 -64.78670 18.30376 colonized hardbottom colonized pavement w/ sand veneer <10%
3/25/2004 -64.78713 18.30433 colonized hardbottom colonized pavement w/ sand veneer 10-30% sc
4/2/2004 -64.78413 18.30728 rhodoliths/ macroalgae rhodoliths+macroalgae dense
4/2/2004 -64.78560 18.30736 rhodoliths/ macroalgae rhodoliths+macroalgae moderate <10%
4/2/2004 -64.78573 18.30665 colonized hardbottom colonized pavement w/ sand veneer
4/2/2004 -64.78580 18.30601 colonized hardbottom colonized pavement <30%
4/2/2004 -64.77466 18.30663 rhodoliths/ macroalgae rhodoliths+macroalgae dense 50-70%
4/2/2004 -64.77583 18.30628 rhodoliths/ macroalgae rhodoliths+macroalgae dense 30-50%
4/2/2004 -64.77496 18.30550 rhodoliths/ macroalgae rhodoliths+macroalgae dense 70%
7/19/2004 -64.79280 18.26760 colonized hardbottom colonized pavement 70%
7/19/2004 -64.67720 18.33800 coral reef patch reef 70% live
7/19/2004 -64.76790 18.27500 colonized hardbottom colonized pavement 70% live
7/20/2004 -64.74860 18.27500 colonized hardbottom colonized pavement w/ sand c
7/20/2004 -64.72550 18.26980 coral reef linear reef 70% live
7/21/2004 -64.79780 18.26480 colonized hardbottom colonized pavement 50% live
7/21/2004 -64.82357 18.24958 coral reef spur and groove 50% live
7/21/2004 -64.82240 18.24870 coral reef spur and groove w/ sand c
8/18/2004 -64.77564 18.30117 rhodoliths/ macroalgae rhodoliths+macroalgae dense w/ sand c
8/18/2004 -64.77602 18.30093 rhodoliths/ macroalgae rhodoliths+macroalgae dense 50%
8/18/2004 -64.77650 18.30106 rhodoliths/ macroalgae rhodoliths+macroalgae dense <30% sponges
8/18/2004 -64.77616 18.30402 rhodoliths/ macroalgae rhodoliths+macroalgae sparse <30% sponges
8/18/2004 -64.77648 18.30413 rhodoliths/ macroalgae rhodoliths+macroalgae sparse <30% sponges
8/18/2004 -64.77712 18.30466 rhodoliths/ macroalgae rhodoliths+macroalgae sparse <30% sponges
8/18/2004 -64.75716 18.24423 coral reef linear reef deep water
2/24/2005 -64.75228 18.29810 rhodoliths/ macroalgae macroalgae sparse 30-50% ma
2/24/2005 -64.75170 18.29743 sand sand <10%
2/24/2005 -64.75093 18.29728 scattered coral/ rock scattered coral/ rock 10-30% sc
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Table 1 cont'd. Ground truthing coordinates and habitat at each point.  The columns labeled type and descriptor describe
the structure and make-up of each site.  

DATE_ X Y HABITAT CATEGORY TYPE DESCRIPTOR
2/24/2005 -64.73491 18.30348 coral reef patch reef aggregate
2/24/2005 -64.73527 18.30375 sand sparse ma <10%
2/24/2005 -64.73575 18.30422 coral reef patch reef aggregate
2/24/2005 -64.73598 18.30428 rhodoliths/ macroalgae sparse ma <30%
2/24/2005 -64.73797 18.30857 coral reef spur groove 50-70%
2/24/2005 -64.75220 18.29938 rhodoliths/ macroalgae macroalgae 30-50%
2/24/2005 -64.75197 18.29963 coral reef patch reef aggregate 70%
2/24/2005 -64.75172 18.29960 coral reef patch reef aggregate 70%
3/3/2005 -64.74599 18.30361 coral reef patch reef individual 70% live
3/3/2005 -64.74636 18.30421 coral reef patch reef individual 70% live
3/3/2005 -64.74672 18.30652 rhodoliths/ macroalgae rhodoliths+macroalgae sparse w/ sand c
3/3/2005 -64.74809 18.29961 coral reef patch reef individual 70% live
3/3/2005 -64.74735 18.30027 coral reef patch reef individual 50% live
3/3/2005 -64.74716 18.30106 coral reef patch reef individual 50% live
3/3/2005 -64.74687 18.30188 rhodoliths/ macroalgae rhodoliths+macroalgae sparse w/ sand c
3/3/2005 -64.74686 18.30224 rhodoliths/ macroalgae rhodoliths+macroalgae sparse w/ sand c
3/3/2005 -64.73753 18.31112 coral reef spur groove 50%
4/12/2005 -64.75946 18.29308 rhodoliths/ macroalgae macroalgae patchy <30%
4/12/2005 -64.75915 18.29295 boat decomposed boat
4/12/2005 -64.75896 18.29285 boat decomposed boat
4/12/2005 -64.75886 18.29282 colonized hardbotto colonized pavement
4/12/2005 -64.76041 18.29299 rhodoliths/ macroalgae macroalgae patchy 30-50%
4/12/2005 -64.76061 18.29354 rhodoliths/ macroalgae macroalgae patchy 50-70%
4/12/2005 -64.76885 18.29832 rhodoliths/ macroalgae macroalgae patchy >70%
4/12/2005 -64.76746 18.29840 rhodoliths/ macroalgae macroalgae patchy <10%
4/12/2005 -64.75694 18.30062 rhodoliths/ macroalgae macroalgae patchy <30%
4/12/2005 -64.75709 18.30072 rhodoliths/ macroalgae macroalgae continuous
4/12/2005 -64.75775 18.30104 rhodoliths/ macroalgae macroalgae continuous
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6. Once at the site and the towfish is launched line-up for the first survey line use the 

Left Right indicator window to aid steering 
7. The data display window will show the line to be surveyed, logging status, and 

other relevant information.   
8. Once you get on the line hit ‘ctrl s’ to start logging the GPS data – at the end of a 

line hit ‘ctrl e’ to end logging, the next line will automatically be the active line.   
9. To start a new area go to line unload file and the go to select file 
 
 
 
Data acquisition computer 
1. start up Sea Scan PC 
2. ‘rub test’ the towfish before leaving the dock 

a. click the Power button and then select the 300 kHz towfish 
b. click on Manual SOG (it should turn red) then click the up or down arrows 

to increase the speed to about 3 knots 
c. go back to the towfish and wet your hands and rub the side of the 

transducer – an image should appear on both channels.  If not check your 
connections again 

3. turn off the power until ready to collect data 
4. Once at the site turn on the power and turn off the Manual SOG (should not be 

red) 
5. the boats position should be across the top of the screen 
6. lower the towfish to approximately 3-5 meters off the bottom [this is measure 

using the Len button and dragging the cursor from Nadir (the middle line in the 
screen) across to the first bottom return] 

7. Go to Options and open the Status Boxes and open Data storage status so you can 
see the filename – leave this open on the side 

8. Click the Gain button to open the gain adjustment window – use this like a 
synthesizer on a stereo to adjust the image for each channel.  Adjust it to the 
clearest picture possible and try not to adjust it during data collection if possible 
But make sure you can clearly see objects in the image.   

9. As soon as you start a line and the boat driver hits ‘ctrl s’ on Hypack Max you 
click on Auto Save to start a new file (you will write this filename down in a 
spreadsheet).   

10. At the end of a line hit Auto Save again and write down the filename and time in 
the spreadsheet.  Also either winch up the towfish to the same as the water depth 
or speed up the boat a little to raise the towfish.  Do not stop logging during turns 
unless you cannot see the bottom clearly.   

11. at the end of the Day hit the Power to turn it off (Red indicates power is on) 
12. You must simultaneously enter information into an excel spreadsheet.  Have that 

spreadsheet ‘new sss worksheet’ open so you can hit ‘alt tab’ to switch back and 
forth.  (be aware if when you return to sea scan PC it does not show an image just 
click in the waterfall display it should come back and it does not mess up the data) 

51



F-7: Recreational Fisheries Habitat Assessment Project  Appendix I 
Study 4: Mapping Essential Fish Habitat with Side Scan Sonar 
Period: FY 2001-FY2005 

a. Enter the information under the headings, headings in Blue will update 
automatically but you have to enter a new direction change and date 
etc…, 

b. Enter the filename given in the Data storage status window at the start of 
a line, end of line and whenever you winch in or out the cable.  Enter the 
depth, cable out (in meters).  In the comments box enter ‘sol’ for start of a 
line or ‘eol’ for the end of line.   
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Settings for Sea Scan PC data acquisition 
 
Use these windows to reset the settings for Sea Scan PC after reinstalling the software.  These settings 
are the settings used during data acquisition.   
 

 
Found under Options →Settings→Data Storage Settings  
 
 

 
Found under Options →Settings→Survey File 
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Found under Options →Settings→User 
 
 
 
 
 
 

 
Found under Options →Settings→Units 
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Under external → navigation→ Settings 
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Post Processing Side Scan Sonar Images 

 
 
Computer = Data acquisition computer (LINDSEY computer) 
1. Start up SeaScan PC Review 

1.1. Open the file .mst for the day the data was collected.  Note: the files are saved 
according to the date and month (not year).  If more than one session was 
conducted on the same day (but different years) the computer automatically 
assigns the next highest filename available (while in collection mode) and both 
years for that date will be in the same file folder.   

1.1.1. Open the excel spreadsheet for that day and find the files that correspond 
to those you want to process.  Use the spreadsheet to find the files that start a 
line and end a line or have features/targets of interest. 

1.2. In SeaScan PC Review – open the first file for the line you want to process. 
1.2.1. Review the file and if the spreadsheet indicates there are annotations 

check the show button under Options – Annotations.   
1.2.2. If the image has residual noise - click the Filter button on the left of the 

display (Figure 1)– then click somewhere in the “waterfall” display (near a 
feature of interest if needed).  This opens the Filter dialog window (Figure 
2).   

1.2.3. click the Record button and scroll the available filters down to Spike 1 
and select Spike 1 – you can only undo the last filter run, if need be cancel 
the whole filter process and don’t save the new image and redo. 

1.2.4. click the entire image filter button – OK 
1.2.5. close the Image Filter window 
1.2.6. save the new image under File – Save as.  Save the filtered image into the 

zip drive or a temp folder for burning to a CD once you start using the newer 
data acquisition computer with the CDRW 

1.2.7. Play the next file in time and repeat the filter process 
Important – try to play all the files and save them in the order they were 
collected.  If you filter them out of sequence Isis Sonar will have trouble processing 
the navigation and may cause problems in the mosaic process.  Filtering images and 
conducting a “save as” alters the files’ date and timestamp.   
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Figure 1:  Main Waterfall window.   
 

 
57



F-7: Recreational Fisheries Habitat Assessment Project  Appendix II 
Study 4: Mapping Essential Fish Habitat with Side Scan Sonar 
Period: FY 2001-FY2005 
 

Click record button before running filter

Entire Image Filter Button 
 

 
 Figure 2: Filter Dialogue Window 
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Mosaic Procedure Basics 
 
 

Computer = MOSAIC computer 
 
In Isis Sonar 
1. Playback all of the xtf files for a line to check them for targets [to make note of] and 

determine if they are usable images.   
 
2. Bottom Track all the files for that survey line before continuing.  The files must be 

accurately bottom tracked in order to get the towfish altitude.  The towfish altitude is 
used to determine layback.  [Bottom tracking may be done after snipping several files 
together but must be done before fixing time or generating an ASCII report.]   

 
2.1. To Bottom Track Playback a file in Isis.  In the Isis Bottom Track dialogue 

box be sure Method is set to Amplitude.  A thin red line should run vertically in 
the Main Waterfall Window this is the bottom track line (Figure 1).  If this line 
wanders off or cuts into the bottom adjust the Level (a higher % moves the line 
deeper towards the bottom or cuts into the image, a lower % moves the line 
towards nadir, away from the bottom).  Holdoff is the distance the towfish is off 
the bottom (altitude) make a guess at what this should be (generally we run at an 
altitude of 3-5m so set the holdoff at 2.5m) the track line will not search for the 
bottom return until beyond the holdoff level.  [Under Options you can put a 
check in the Save newly tracked altitude back into the original XTF file box.  
This will save the new bottom track (Note: if you have problems uncheck the 
box and then just start over and recheck the box when you get the right 
adjustments, it will continuously save the new bottom track over previous data).  
You can save portions of the new bottom track by checking and unchecking the 
box multiple times in one file.]   

2.1.1. Replay the line and check the bottom track (to do this be sure to uncheck 
the Save newly tracked altidude box and turn off the bottom track in the 
Bottom track dialogue box).  While you replay the line you can hit the space 
bar to pause the playback where the bottom track wanders.  See Figure 1 for 
the slowdown and speedup playback buttons.  If the bottom track wanders 
click in the main waterfall window where the track leaves the bottom.  Then 
go to File- Goto-Ping-OK (this will take the file back to the last point you 
clicked in the waterfall window when you replay the line).  Adjust the Level 
and Holdoff again and replay the segment (by hitting the space bar again), 
pause it again and keep going back to the Ping until you get it at the right 
level.  Then let the line play through being sure to save the new bottom track 
segment by placing a check in the Save newly tracked altitude box.   

 
3. Snipping files: If depth or the amount of cable out changes during a survey line you 

must process only those files that have the same depth and cable out as one.  If two 
files have differing amounts of cable out process those separately, they will have 
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different layback.  Snip files with the same depth and cable out together to make one 
longer file.   

 
3.1. Snip files – to snip files together in Isis Sonar go to Tools →Snip File create a 

filename for the new file you are creating (example: 101_103.xtf,  for snipping 
files 20nov101.xtf, 20nov102.xtf, and 20nov103.xtf together) playback the files 
you want to snip in the proper order.  When you are done playing back the files 
turn off the snip file function by going back to Tools → Snip File and clicking it, 
this will automatically turn it off.  You can also hit the shortcut key on the tool 
bar that looks like scissors (Figure 1).   

 
4. FixTime – You must fix time in the xtf files so the navigation and time stamps will 

run smoothly.  If you do not do this you may have smearing of pixels or gaps in the 
final mosaic.   
4.1. First copy and paste the fixxtime.exe file to the folder you are working in.  The 

original can be found in C:\TEI\fixxtime.exe 
4.2. To Fixtime replay the snipped file you just created or a single file not snipped.  

Write down the time (see Figure 1) at the start of the file and at the end of the 
file.  Add up the total number of pings in the snipped file (there are 1000 pings 
per one file so if you snipped 3 files together you have 3000 pings).   

4.3. Open a DOS prompt – change the directory to the folder that contains the file 
you want to fix time in.  Do this by typing in EXACTLY   
cd\Documents and Settings\DFW\My Documents\Side Scan Sonar\SSS 
Images\stj5a\20 nov 02   <hit ENTER>  (note: stj5a is the folder for the area you 
are mosaicking and 20 nov 02 is the folder that contains the file you want to fix 
time, these will change to current files you are working in that you copied the 
Fixxtime.exe to).  See Figure 2 for an example of the Fixxtime dialogue window.   

4.3.1. Next type fixxtime  <hit ENTER>  (Yes, you must type in two xx’s in 
fixxtime.)   

4.3.2. You will be asked to type in the name of the file. Enter the entire filename 
(example: 101_103.xtf)  <ENTER> 

4.3.3. Then you will be asked to enter the start date and time.  This can be found 
in the Parameters Window of Isis (see Figure 1).  <ENTER> 

4.3.4. Then enter the end date and time as above <ENTER> 
4.3.5. Then enter the number of pings in the file  <ENTER> 
4.3.6. When it is finished fixing the time replay the file in Isis Sonar.  The time 

and number of pings should scroll sequentially in the Parameters Window.   
Note:  Sometimes SSPC review (on the Lindsay computer) alters the time stamp 
and date (if one file was post processed and saved one day and a second file was 
post processed at a later date they will be assigned different dates and times) You 
MUST change the date and time for the start date and end date to match.  
[Example: if one file was dated 25nov02 and the second file was dated 16nov02 
you must enter the same date for the start and end in fixxtime.exe.  Similarly the 
time may be off.  If one file time was 17:05:02 and the end file time on the second 
was 10:23:26 you must adjust the time to run sequentially.  You can do this by 
looking at the original files’ time stamps for start and finish and changing the time 
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in one file, if file 20nov101.xtf has a start time of 17:05:02 and end time of 
17:07:30, and file 20nov102.xtf has a start time of 10:23:26 and an end time of 
10:26:26 you can change file 102’s time to start 1 second after file 101, so it 
would start 17:07:31 and end 3 minutes later (because it’s total run time was 
exactly 3 minutes (10:26:26 minus 10:23:26 = 3 minutes) so the end time for the 
file in fixxtime.exe will be 17:10:31].   
 

5. Layback-Next generate an ASCII Report.  To do this go to Tools→ASCII Report, 
put a check in the box for Form 1 and click Setup Form 1.  You should get a form 
that looks like Figure 3.  Put checks in the corresponding boxes.  Change the time in 
the When to output box to every 1 second.  Click the Browse button to create a text 
file in a folder you specify.  Click OK and then Click OK in the ASCII Report 
window.  Replay the file (Note: you can just hit the home key on your keyboard to 
replay the line from the beginning).  After the file plays back turn off the ASCII 
Report by going back to Tools →ASCII Report and removing the check in the Form 
1 Box.   
5.1. Go to the folder you put the ASCII report into and open the text (.txt) file.  Insert 

a line at the beginning of the file with identical information as the line below 
except make the time 1.000 second before the start of the files’ time.  Example: if 
a file had a start time of 13:54:53.000 make the time for the new line 
13:54:52.000.  Do the same at the end of the file but make the time 1 second 
later.  Make the altitude the same as the previous line.  Save the file and close the 
window.   

5.2. Open Microsoft Excel.  Open the file you just made as a delimited text file.  
When the Import text dialogue box opens click Delimited and Next.  Uncheck the 
Tabs box and put a check in the comma box and other box then type m in the 
other box, then click Next.  Highlight the first column and click Date in the 
Column data format box.  Click Finish.  You should get an Excel Spreadsheet 
with the first column as dates, the second as time in HH:MM:SS, and the third 
column should contain the towfish altitude without the m for meters.   

5.2.1. In the 4th column enter the total water depth in meters from the field 
sheets (spreadsheet) and in the 5th column enter the cable out in meters.   

5.2.2. The 6th column is for the layback calculation.  This is a formula based on 
the equation 27.6])63.1([ 22 +−+−= altitudedepthcableoutLayback  
Where 1.63 is the height of the tow point and 6.27 is the offset, all 
measurements should be in meters.  In excel the formula should read:  
=(SQRT(E1^2-(D1+1.63-C1)^2)+6.27) 

where column E is the cable out, column D is the depth, and column C is the 
altitude.  Copy this formula and the data for the 4th and 5th columns down the 
spreadsheet.  Then highlight the three columns and copy and Paste special it 
as values.  Save the spreadsheet as a comma delimited (.csv) file and close 
the file.   

5.2.3. Go back to Isis and either close Isis or playback a completely different file 
than the one you are working on.   
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5.2.4. Go to Windows explorer and rename the csv file you just made as a txt file.  
You will have to give it a different name followed by .txt.  I generally name 
it the same as the original file but with 2 in front (example: 2line23.txt).   

5.3. Open NavInXtf.exe  this is found in C:\TEI\Nav in Xtf 
5.3.1. See Figure 4.  In the box/ section labeled 1 click Browse and select the txt 

file that contains the layback information you just created (the file you just 
renamed eg. 2line23.txt).   

5.3.2. In the box/ section labeled 2 click Browse and open the xtf file you want to 
put the layback into (eg line23.xtf).  Then you will be asked to save a backup 
of the file ALWAYS SAVE A BACKUP to a folder labeled Backup.   

5.3.3. In section 3 make sure the top box labeled Ship is checked (it shades 
lighter color than the others) and the bottom box Sensor&Ship is checked.  
Then click Process and Exit when it is done.   

5.3.4. Go back to Isis and open View→Layback.  Then replay the file you just 
added layback to.  Layback should scroll in the Layback window.  This file 
is now ready to be added to others to create a single line file or be mosaicked 
if you already snipped all of the files for that one line.  Repeat the above 
layback and NavinXtf process for all files in that line if they were not 
snipped together.  When all files have layback and have been time corrected 
go to Step 6.   

6. Snip all of the files that make a single line (a single line should contain 10-11 files) 
using the same process as described in 3 above.   
6.1. Be sure to note the dates and times for each file.   
6.2. Fixtime for the newly created snipped file as was done before but name the file 

after the line that it represents (eg. line12.xtf).  Save the line file into the folder 
for the corresponding area rather than the corresponding date folder (example: 
C:\Documents and Settings\DFW\My Documents\Side Scan Sonar\SSS 
Images\stj5a).  To fixxtime you will have to copy the Fixxtime.exe to the mosaic 
folder you are working out of and when in DOS change the directory to the 
folder that contains both the file you want to fix and the fixxtime.exe.  (Example: 
cd:\Documents and Settings\DFW\My Documents\Side Scan Sonar\SSS 
Images\stj5a).  Once you have Snipped the files together for a single survey line 
and fixed time for that new file go to step 7.   

 
7. Coverage map – Now the line file is ready to be mosaicked.  Go to Tools – 

Coverage Map and Mosaic and check the Full DelphMap mosaic box.  Two 
windows should come up.   
7.1. One is the Delph Mosaic and DTM window (Figure 5).  In the Delph Mosaic and 

DTM window select set projection and bounding box.  Change the resolution to 
0.1 (Figure 6) then OK.  In the Delph Mosaic and DTM window select More 
Options and put checks in the boxes as in Figure 5.  Select Setup under Apply 
Layback to nav in mosaic and put checks in the apply layback and Use logged 
layback value boxes (Figure 7).   

7.2. The second window that comes up after you check the Full DelphMap mosaic 
box is the Coverage Window (Figure 8).  Playback the line and this window will 
show the towfish’s track.  When the line is done playing back go to Nav and 

 62



F-7: Recreational Fisheries Habitat Assessment Project  Appendix III 
Study 4: Mapping Essential Fish Habitat with Side Scan Sonar 
Period: FY 2001-FY2005 

select smooth navigation.  This will bring up a window like Figure 9.  Leave the 
default values and click Smooth now several times, 10-15 times, then close the 
window.  When the Lock Coverage map dialogue appears select YES to lock the 
coverage map.  Save the navigation to a txt file into a folder under the area you 
are mosaicking called navigation.   

7.3. Now put a check in the box next to Build Sidescan Mosaic in the Delph Mosaic 
and DTM window.  Click Start Mosaic and name the line you are mosaicking 
after the line it corresponds to (eg. line23).  Save this line in a folder for the area 
you are working on (eg. stj5a) under the folder MOSAICS  (C:\Documents and 
Settings\DFW\My Documents\Side Scan Sonar\MOSAICS).  The add scrolled 
data to mosaic message should highlight and a message successfully started 
mosaic should appear.  Playback the file you are mosaicking again; when it is 
done playing back, click the Done button and close the Delph Mosaic and DTM 
window and the Coverage Window.   

7.4. If DelphMap was already open the data will automatically scroll into the mosaic.  
If it was not open go to step 8.   

 
In DelphMap 
8. Open the project you want to work on or start a new project.   

8.1. To insert the line/ layer you just created in Isis right click on Image Layers 
(Figure 10) and select the line you created.  This will insert the line.  You may 
insert all the lines at the end when you have finished creating them in Isis or as 
you go.   

8.2. You can move a layer in DelphMap by clicking and dragging a line name up or 
down.  The line that appears on top in the window on the left will also be on top 
in the mosaic.  Lines on top will cover-up the line below.   

8.3. Once you have finished a mosaic Merge all of the lines into one file to be printed 
[if you do not merge the files printing may take several hours].   

8.3.1. Under Tools- go to Merge image layers and select the layers you want to 
merge (Figure 11).  You can merge as few as two layers or the whole 
mosaic.  You should merge the whole mosaic to print.  Unselect the Insert 
output layer into project.  Select an output file location (use the same folder 
as the original mosaic).  Click Merge.   

8.3.2. Once it is done open a new DelphMap project and insert the layer as 
described in 8.1 above.  [It is a good idea to also create a GeoTiff of the 
mosaic – do this by right clicking on the layer name in the left column 
and selecting export] 

 
Printing 
9. To print a Mosaic using the large plotter first connect the plotter and turn it on – 

before opening DelphMap.  Then open DelphMap.   
9.1. Select Project – Print Setup and the plotter.  Under the Properties page (Figure 

12) check that the paper size is correct.   
9.2. IMPORTANT  There are hidden settings in the Plotter that must be checked 

each time you want to print.  If you do not uncheck the Enable SpoolSmart 
setting you will not be able to print the mosaic properly.  In order to access these 
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settings you must Click on About (Figure 12) and then place the cursor arrow 
over the hp invent symbol and hold down F8 while hitting <ENTER> (Figure 
13).  This will bring up the Special Options window (Figure 14).  Uncheck the 
box next to 16 enable SpoolSmart and click OK (Figure 14).   

9.3. Next select the Scale to Fit box in the properties page (Figure 12).  This will 
open the ZoomSmart Settings window (Figure 15).  Be sure that the paper size is 
correct and check the Fit the Document to this paper box and verify the paper 
size.  Click OK.   

9.4. Finally go to Print preview and Map Layout under Project and enter a title and 
change the scale if necessary.  You should see a preview similar to Figure 16.  (I 
have found for a mosaic of approximately 1 square mile a scale of 1:2300 works 
well).   Click OK 

9.5. Now go back to the print window and print the file.  It may take several minutes 
(10-15) to spool and start printing.  The print process is slow and may take an 
hour or more if you did not merge the files.   

 
 
If you have any other troubles consult the manuals for Isis and DelphMap or call 
Tech support for Triton Elics International at (831) 722-7373.   
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Isis Main Window 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 1.  Isis Main Window.   
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Figure 2.  DOS steps to fix time for Isis Sonar for DelphMap mosaicking 

Type 
fixxtimeLocation of 

the 
fixxtime.exe 
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Change to 
1 second 

Browse to 
create a txt file 
in a folder you 
specify 

Click OK 
when done

Figure 3.  ASCII Report form.  Put checks in the corresponding boxes as shown here.   
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Step 1 

Step 2 

Make sure 
these buttons 
are clicked 

Step 3 
Click process 
when done 

Figure 4. Navinxtf Window.   
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Figure 5. Window to build the mosaic.   
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Change to .1 m 

Figure 6.  Projection window.  Input and output should default correctly.  Change the 
Grid resolution to 0.1 m.   
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Figure 7.  Check the Apply Layback to nav in mosaic.   
Under setup check the use logged layback value.   
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Figure 8. Coverage Window.  Sonar path is in red.  Go to Nav – Smooth Navigation 10-
15 times and save the coverage points as a txt file.   
 
 

 
Figure 9. Smooth navigation window.   
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Leave defaults.  Click Smooth now 10-15 times.   

 

Right click 
to insert 
layers or 
lines  
 
drag layers 
to move up 
or down in 
the mosaic 
window 

Figure 10.  Delphmap Window with a mosaic.   
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Figure 11.  Merge Layer Window.  Select layers to merge.   
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Make sure 
paper size is 
correct 

Click scale 
to fit 

Click About 
for hidden 
settings 

Figure 12.  Printer/ plotter setup.  Select About and go to figure 13.   
 
 

 

Place cursor arrow here 
press and hold F8 and hit 
ENTER 

Figure 13.  You must change hidden settings to print properly.  Place the cursor arrow 
over the hp invent symbol and press and hold the F8 key while hitting <ENTER> this 
gives you Figure 14. 
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uncheck 

Figure 14.  After you get to these hidden settings from Figure 13 uncheck the box next to 
16 Enable SpoolSmart.  Leave all others as the defaults.  Click OK. 
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Figure 15.  Click on the Scale to Fit button in the Properties page (see Figure 12).  Make 
sure the Page size matches the size of paper you have loaded in the plotter.  Click on the 
Fit the Document to this paper and select the right paper size.  Click OK 
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Figure 16.  Print preview of the final mosaic 
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